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i-Tree is a state-of-the-art, peer-reviewed software suite from the USDA Forest Service that 

provides urban and community forestry analysis and benefit assessment tools. The i-Tree 

tools help communities of all sizes to strengthen their urban forest management and 

advocacy efforts by quantifying the environmental services that trees provide and assessing 

the structure of the urban forest. 

 

i-Tree has been used by communities, non-profit organizations, consultants, volunteers, and 

students to report on the urban forest at all scales from individual trees to parcels, 

neighborhoods, cities, and entire states. By understanding the local, tangible ecosystem 

services that trees provide, i-Tree users can link urban forest management activities with 

environmental quality and community livability. Whether your interest is a single tree or an 

entire forest, i-Tree provides baseline data that you can use to demonstrate value and set 

priorities for more effective decision-making. 

 

Developed by the USDA Forest Service and numerous cooperators, i-Tree is in the public 

domain and available by request through the i-Tree website (www.itreetools.org). The Forest 

Service, Davey Tree Expert Company, Arbor Day Foundation, Society of Municipal Arborists, 

International Society of Arboriculture, Casey Trees, and State University of New York College of 

Environmental Science and Forestry have entered into a cooperative partnership to further 

develop, disseminate, and provide technical support for the suite. 

 

 

The use of trade, firm, or corporation names in this publication is solely for the information 

and convenience of the reader. Such use does not constitute an official endorsement or 

approval by the U.S. Department of Agriculture or the Forest Service of any product or 

service to the exclusion of others that may be suitable. The software distributed under the 

label “i-Tree 2017 Suite” is provided without warranty of any kind. Its use is governed by the 

End User License Agreement (EULA) to which the user agrees before installation. 

 

 

The i-Tree Development Team actively seeks feedback on any component of the project: the 

software suite itself, the manuals, or the process of development, dissemination, support, and 

refinement. Please send comments through any of the means listed on the i-Tree support page: 

www.itreetools.org/support/. 

 

About i-Tree 

 Disclaimer 

 Feedback 

http://www.itreetools.org/
http://www.itreetools.org/support/
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The 2017 i-Tree software suite includes the following urban forest analysis tools and utility 

programs: 

 

 

i-Tree Eco provides a broad picture of the urban forest or trees in your study area. It is 

designed to use field data from complete inventories of trees or randomly located plots 

throughout a community along with local hourly air pollution and meteorological data to quantify 

urban forest structure, environmental effects, and value to communities. 

 

i-Tree Hydro is the first vegetation-specific urban hydrology model. It is designed to model the 

effects of changes in urban tree cover and impervious surfaces on hourly stream flows and 

water quality at the watershed level. 

 

i-Tree Streets focuses on the ecosystem services and structure of a municipality’s street tree 

population. It makes use of a sample or complete inventory to quantify and put a dollar value on 

the trees’ annual environmental and aesthetic benefits, including energy conservation, air 

quality improvement, carbon dioxide reduction, stormwater control, and property value 

increases. 

 

i-Tree Vue allows you to make use of the freely available National Land Cover Database 

(NLCD) satellite-based imagery to assess your community’s land cover, including tree canopy, 

and some of the ecosystem services provided by your current urban forest. The effects of 

planting scenarios on future benefits can also be modeled. 

 

 

i-Tree Landscape is an online tool that allows you to explore geospatial data for an area of 

interest. It makes use of datasets, such as land cover and U.S. Census data, to provide local 

information, tree benefits, and planting prioritization by designated management boundaries. 

 

i-Tree Design is a simple online tool that provides a platform for assessments of individual trees 

at the parcel level. This tool links to Google Maps and allows you to see how tree selection, tree 

size, and placement around a building affects energy use and other benefits. This tool not only 

estimates tree benefits for the current year, but also projects benefits over time to a user-

specified year in the future. 

 

i-Tree Products 

 Desktop Applications 

 Web Applications  

https://www.itreetools.org/eco/index.php
https://www.itreetools.org/hydro/index.php
https://www.itreetools.org/streets/index.php
https://www.itreetools.org/vue/index.php
https://landscape.itreetools.org/
https://design.itreetools.org/
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i-Tree Canopy offers a quick and easy way to produce a statistically valid estimate of land 

cover types (e.g., tree cover) using aerial images available in Google Maps. The data can be 

used by urban forest managers to estimate tree canopy cover, set canopy goals, and track 

success; and to estimate inputs for use in i-Tree Hydro and elsewhere where land cover data 

are needed. Canopy also estimates tree benefits based on the amount of tree cover in your 

study area. 

 

i-Tree Species (now accessible online!) is designed to help users select the most appropriate 

tree species based on the species potential environmental services and geographic area. 

Users select and rank the importance (0-10) of each environmental service desired from trees. 

The program then calculates the best tree species based on the user-provided weighting of 

environmental benefits of tree species at maturity. 

 

i-Tree MyTree (new!) is a quick and easy mobile tool allowing you to explore the benefits 

provided by the trees near you. 

 

i-Tree Database (new!) is an online system designed for international users outside of the 

United States, United Kingdom, Canada, and Australia to submit properly formatted 

international pollution and weather data, location information, new species information, and 

other requirements needed for the i-Tree Eco model to process in a new, previously 

unsupported study area. The submitted information will be vetted by the U.S. Forest Service 

and integrated into the Eco model as a new international location that would be available for 

automated processing in future updates of Eco. 

 

 

i-Tree Storm helps you to assess widespread community damage in a simple, credible, and 

efficient manner immediately after a severe storm. It is adaptable to various community types 

and sizes and provides information on the time and funds needed to mitigate storm damage. 

 

  

 Utilities 

https://canopy.itreetools.org/
https://species.itreetools.org/
http://www.itreetools.org/mytree/
http://www.itreetools.org/database/
https://www.itreetools.org/storm/index.php
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Components of the i-Tree software suite have been developed over the last few decades by the 

U.S. Forest Service and numerous cooperators. Support for the development and release of the 

2017 i-Tree software suite has come from USDA Forest Service Research, State and Private 

Forestry, and their cooperators through the i-Tree Cooperative Partnership of the Davey Tree 

Expert Company, Arbor Day Foundation, Society of Municipal Arborists, International Society of 

Arboriculture, Casey Trees, and State University of New York College of Environmental Science 

and Forestry. 

 

i-Tree Eco 

 

i-Tree Eco is an adaptation of the Urban Forest Effects (UFORE) model, which was 

cooperatively developed by the U.S. Forest Service Northern Research Station (NRS), USDA 

State and Private Forestry's Urban and Community Forestry Program and Northeastern Area, 

Davey Tree Expert Company, and SUNY College of Environmental Science and Forestry.  

 
The UFORE model was conceived and developed by David J. Nowak and Daniel E. Crane 

(USFS, NRS), and Patrick McHale (SUNY-ESF). The UFORE software was designed and 

developed by Daniel E. Crane and its graphical user interface (GUI) by Lianghu Tian and Mike 

Binkley (The Davey Institute). Many individuals contributed to the design and development 

process of the UFORE application including Mike Binkley (The Davey Institute), Jaewon Choi 

(SUNY-ESF), Daniel E. Crane (NRS), Greg Ina (The Davey Institute), Robert E. Hoehn (NRS), 

Jerry Bond and Christopher J. Luley (Urban Forestry LLC), Patrick McHale (SUNY-ESF), David 

J. Nowak (NRS), Jack C. Stevens (NRS), Lianghu Tian (The Davey Institute), Jeffrey T. Walton 

(Paul Smiths College), and Robert Sacks (Bluejay Software).  

 
New modeling functions, desktop processing capabilities, and updates for i-Tree Eco versions 

were developed and integrated by members of the USFS-NRS and The Davey Institute based 

on newly available research from NRS and feedback from i-Tree users. i-Tree Eco Development 

Team members and contributors include Satoshi Hirabayashi, Alexis Ellis, Daniel Crane, 

Lianghu Tian, Megan Kerr, David Ellingsworth, Allison Bodine, Daniel Vicarel, Mike Binkley, Al 

Zelaya, Jason Henning, Scott Maco, Heidi Siciliano, Michael Leff, Emmanuel Ong, Vidmantas 

Steponavicius, Robert Coville, Arielle Conti, and Erika Teach. 

 

International Support 

 

Many people have contributed to the development of i-Tree Eco to make the application 

functional for users in Australia, Canada, and the United Kingdom. Data for the Australian 

enhancements were provided, in part, by Craig Hallam and Chris Spencer (ENSPEC 

Environment and Risk) and with funding from Arboriculture Australia. Andy Kenney (University 

Acknowledgements 
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of Toronto) helped facilitate data acquisition for Canada. Kenton Rogers, Keith Sacre 

(Treeconomics), and Kieron Doick (Forest Research) assisted with project coordination, data 

acquisition, funding, and development of the United Kingdom Eco model adaptation.  
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i-Tree Eco is a software application designed to use field data from complete inventories of 

trees or randomly located plots throughout a community along with local hourly air pollution and 

meteorological data to quantify urban forest structure, environmental effects, and value to 

communities. Baseline data can be used by managers and researchers for making effective 

resource management decisions, developing policy, and setting priorities. 

 

From project start to finish, Eco is a complete package that provides users with the following 

components: 

 Detailed, statistically based sampling and data collection protocols. These protocols 

allow for estimation of totals and variation related to urban forest structure and 

population effects. 

 A mobile data collector for web-enabled smartphones, tablets, or similar devices that can 

be used for field data collection. 

 A central computing engine that makes scientifically sound estimates of the effects of 

urban forests based on peer-reviewed scientific equations to predict environmental and 

economic benefits. 

 Summary reports that include charts, tables, and a written report. 

 

 

 

 

 

 

 

 

 

Though i-Tree Eco was originally developed for the United States, growing interest among 

international urban foresters has spurred improved model functionality in other countries as time 

and limited resources have permitted. 

 

Supported Countries 

 

Eco v6.0 has been adapted for use throughout Canada, Australia, and the United Kingdom with 

the necessary species information, location information, and pollution and weather data 

preprocessed and available in the application. 

 

About i-Tree Eco 

 International Projects 

 

 

To install the i-Tree Eco software, please see the Eco Guide to Installing 

Software for system requirements and installation instructions. 

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InstallingEco.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InstallingEco.pdf
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Other International Eco Users 

 

International users completing projects in countries other than Canada, Australia, and the U.K. 

will be required to submit additional data using the i-Tree Database web application. The new i-

Tree Database system has been developed to support the increasing number of international 

projects. Users in unsupported countries will work with i-Tree Database to add the necessary 

tree species information, location information, and properly formatted pollution and precipitation 

data for their project study area. Once data has been submitted, it can be incorporated into a 

future version of Eco allowing for automated processing in these newly added locations. 

  

 

 

International users are encouraged to read more about the requirements and 

process of completing an Eco project in an unsupported location. Additionally, 

certain limitations apply to international projects outside of the United States 

both in terms of functionality and required inputs. This information is outlined in 

the Eco Guide to International Projects. 

Eco Guide  

http://www.itreetools.org/database/
http://www.itreetools.org/database/
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InternationalProjects.pdf
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Eco v6.0 offers several significant upgrades over previous versions, including the following: 

 

 The newly designed user interface features a modern look with ribbon command bar, on-

screen help text, and easier project setup and data entry forms. 

 

 The simplification of Eco behind the scenes allows users to run the application with less 

required data to collect.  

  

 Interested in the future of your urban forest? The new Forecast model uses the structural 

estimates generated by Eco along with growth and mortality rates to estimate what your 

urban forest will look like in the future. 

 

 Expanded functionality means that users doing a project for a study area in the United 

Kingdom can now do so directly in the application. Location, species, weather, and 

pollution data are all available for the UK. 

 

 Updated and new reports provide users with improved resource analysis options for 

complete inventory and sample projects. 

 

 Users can now choose from multiple years of weather and pollution data. For projects in 

the United States, nine years of data are available. 

 

For more information on the methodology that underlies Eco and the specific model updates, 

visit www.itreetools.org > Resources > Archives. 

 

 

Changes in technology and science over time influence the development of software 

applications. While Eco v6.0 offers many new features, several important differences should be 

noted. The following features are not available in Eco v6.0: 

 

 Custom processing for international projects – In an effort to accommodate growing 

international interest, a new system for handling projects in unsupported countries has 

been developed for Eco v6.0. Previously, international users submitted their project to 

the U.S. Forest Service for manual processing which could take up to 6 months to 

complete. Now, international users can work with the i-Tree Database application to 

have their new international locations incorporated into a future version of Eco. Once 

What’s New in v6.0 

 Important Differences 

http://www.itreetools.org/
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new locations are available in Eco, all users will be able to automatically process 

projects for that study area. 

 

 Particulate matter less than 10 microns (PM10) – The pollutant PM10 is no longer 

included because i-Tree Eco v6.0 analyzes particulate matter less than 2.5 microns 

(PM2.5) which is a subset of PM10. PM2.5 is generally more relevant in discussions 

concerning air pollution effects on human health. 

 

 PDAs – Handheld devices, such as PDAs, are no longer supported for data collection in 

Eco v6.0. Users collecting data with a PDA may use the legacy Eco v5.0 application, 

and then import the data into Eco v6.0. 

 

 Mapping – A basic option to use NLCD imagery to map your results is no longer 

included in Eco. Instead, Eco users interested in working with freely available NLCD 

imagery are encouraged to use the i-Tree Landscape application, which is new to the i-

Tree software suite and offers users the opportunity to explore geospatial data. 

 

 

 

 

 

 

 

 

 

Users with existing Eco projects will be able to make use of i-Tree Eco v6.0. However, i-Tree 

Eco v5.0 will still be available as a legacy Eco application, particularly to accommodate users 

interested in some features, such as data collection using a PDA, that are no longer supported 

in Eco v6.0. The legacy version of the software is included in the i-Tree 2017 software 

installation. 

 
 
 
 
  

 Legacy Version 

 

 

Try using the mobile data collector when you collect your field data. This 

option is compatible with Eco v6.0 and can be used with any web-enabled 

device, such as a smartphone or tablet. 

Tip 

 

 

For more information on model differences from v5.0 to v6.0, please see the 

Eco Guide to Model Differences. 

Eco Guide  

https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_Differencesv5v6.pdf
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Completing an i-Tree Eco analysis can seem like a daunting task, so here are the most 
important things you need to know about using this software: 
 

 Eco projects are highly customizable and thus require a significant amount of planning. 
 

 The Eco model uses field data to estimate forest structure, function, and benefits so you 
will be required to collect data for the individual trees in your study area. 

 
This manual will walk you through the stepwise process of completing an i-Tree Eco project by 
describing the following project phases in more detail: 
 

Phase I: Planning For Your Project 
There are many decisions to be made in order to customize your Eco project. To help 
you work through this planning phase, we have provided a simple decision tree that will 
guide you through the questions that must be answered. 
 
Phase II: Setting Up Your Project 
Once you have planned what type of project you will be doing, you can begin setting up 
your project. Depending on your answers in Phase I, you may need to gather additional 
data or create your sample. Here we will guide you through those next steps. 
 
Phase III: Collecting Your Field Data 
After Phase II is complete, you are ready to move to the data collection phase! In this 
section of the manual, we will help you decide what data you will collect in the field and 
how you would like to collect that data. 
 
Phase IV: Working with Eco 
After you have collected your field data, you will be ready to work directly with the i-Tree 
Eco software. In this section, we will describe each of the components of the user 
interface in detail and walk you through the process of entering or editing your field data.  
 
Phase V: Viewing Your Reports 
Eco provides a large variety of output data in the form of charts, tables, and reports. This 
section of the manual describes what results are available and how to view them. 

 
  

The Eco Rundown 

 

 

Supplement the basic knowledge that can be gained from this manual with 

the topic-specific information in the Eco Guides. That way, you can choose to 

read about the topics that are relevant to your custom project. 

Tip 

http://www.itreetools.org/resources/manuals.php
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Before you get started with Eco there are several decisions that must be made. Use this simple 

decision tree as a guide for Phase I. As you can see, not every question will be relevant to your 

Eco project. In the remainder of this section of the manual, we’ll provide you with more 

information to help answer these questions. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Phase I: Planning For Your Project 

 Decision Tree 

 

 

i-Tree Eco users have developed a number of documents to help others with 

many aspects of project planning and management. These are an excellent 

resource and can be found at www.itreetools.org under Resources > 

Archives > i-Tree Eco Project Planning & Management Resources. 

Tip 

What are the boundaries of your study 

area? 

Will you stratify your 

sample? 

What type of inventory will you do? 

How big will your plots 

be? 

How many plots will you 

inventory? 

Complete Inventory Plot-Based Sample 

Inventory 
Do you have an existing 

inventory? 

Project Basics 

http://www.itreetools.org/
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What are the boundaries of your study area? 

 

An Eco analysis can be done for an entire city, a neighborhood, a park, or even a backyard. 

 

What type of inventory will you do? 

 

A typical Eco project involves inventorying a series of sample plots distributed across a city, a 

large university campus, or some other broad, diverse landscape. This inventory type is referred 

to in Eco as a plot-based sample inventory. Occasionally, however, some users have opted for 

an Eco analysis of small, discrete areas, such as a residential parcel or a commercial property. 

In this case, a complete inventory of all trees on the site makes more sense. Keep in mind, 

however, that data collection on each tree can be intensive, and sites with many trees will be 

very time consuming. 

 

If you decide to do a plot-based sample inventory, skip to the Plot-Based Sample Inventory 

section. Otherwise, read the Complete Inventory section below and then go to Phase II: Setting 

Up Your Project.  

 

 

Do you have an existing inventory? 

 

Users interested in analyzing an existing inventory now have the option to import their existing 

complete inventory data into Eco. Follow the procedure outlined in Phase IV > Adding Data. 

 

 

 

 

 

 
 
 
 
 
 
 

 Project Basics 

 Complete Inventory 

 

 

For more information on importing a complete inventory, please see the Eco 

Guide to Importing an Existing Inventory. 

Eco Guide  

https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InventoryImporter.pdf
https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InventoryImporter.pdf
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If you have decided to conduct a plot-based sample inventory of a large-scale study area, one 

of the most important steps in planning your project will be deciding how to create the random 

sample of plots. This section will help you understand elements of designing a sample such as 

stratification options and the number of plots needed. Your sample design decisions should be 

based on your desired project goals (i.e., the questions you are trying to answer), the available 

resources to manage and complete the project, and the desired precision of the model 

estimates. 

 

Will you stratify your sample? 

 

For some studies, stratifying (subdividing) the study area into smaller units can help clarify 

differences across the area. For example, a stratified sample design with many plots may allow 

for comparison between land use types or neighborhoods and for greater precision of the model 

estimates. However, there will be associated project considerations such as the additional 

resources that will be needed to create maps, obtain permission to access properties, travel to 

plots, and collect field data. Conversely, a simple random sample with no stratification will not 

allow for comparison of sub-units but may still provide sufficient information to achieve the 

project objectives. Ultimately, the decision to stratify should be based on your current and future 

project objectives and your available resources. 

 

 

 

 

 

 Plot-Based Sample Inventory 

 

 

Eco projects can differ greatly. These are only guidelines and may not always 

be applicable to your project. Users are advised to consult with a statistician 

regarding their project sample design if they have specific needs or concerns. 

 

Caution 

 
! 

 

 

A technical article is available at www.itreetools.org under Resources > 

Archives that provides more detail on the effects of sample design options 

on project precision and estimates. See “Effect of Plot and Sample Size on 

Timing and Precision of Urban Forest Assessments” under the Eco 

resources section of that page. 

Tip 

http://www.itreetools.org/
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Review the following options before you decide whether or not to stratify your sample: 

 

 No stratification (simple random sample): In a study with no stratification, plots are laid 

out randomly across the study area. This is a simpler method and offers the advantage of 

true randomness. True randomness, however, might not provide you with a true picture of 

your urban forest. Consider, for example, an extreme case of a city that is divided into two 

land uses: single-family residential (10% of total area) and industrial (90% of total area), with 

all of the trees in the residential district. A true random sample would place 10% of plots in 

residential areas and 90% of plots in the industrial area and would result in an incorrect 

picture of the urban forest. Since in most cities the trees themselves are not distributed 

randomly across land uses or neighborhoods, stratified sampling can offer a more accurate 

picture of the urban forest. 

 

 Stratification (stratified random sample): In a study with stratification, the study area is 

subdivided into smaller units such as neighborhoods or land use classes. This can be done 

prior to determining your plots (pre-stratification) or after data is collected (post-

stratification). 

 

o Pre-stratification: In this method, the study area is divided into smaller classes 

(or strata) prior to determining the plots. The number of plots in each stratum is 

based on which areas are believed to have the greatest variability or are of 

greatest interest. Often the majority of the plots are distributed within residential 

and forest/vacant land uses, as these areas tend to have the greatest density of 

trees. One disadvantage of stratification is that it might make revisiting the same 

plots in the future difficult if land uses change over time. 

 

 

 

Whether you pre-stratify or post-stratify, be sure not to choose too many 

categories or strata. The number of strata used in an Eco project is typically 

between 5 and 10 (for an analysis with 200 total plots) and cannot exceed 14. 

Too many categories can lead to analysis problems, as too few plots may fall 

in some strata. Each stratum should have at least 20 plots. 

Caution 

 
! 

 

 

Stratification is handled differently for complete inventory projects. If you 

are doing a complete inventory project and are interested in collecting 

strata, please read more about it in the Phase III > Choosing Your Data 

section.  

Tip 
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o Post-stratification: In this method, plots are first randomly distributed 

throughout the study area, and then strata boundaries are determined after data 

collection or in the future. Post-stratification allows you to analyze your data into 

multiple schemes. For example, you can use the same plots and field data to 

compare your results by land use types and then change the stratification to 

allow for analysis by political boundaries, neighborhoods, or management units 

as desired. Post-stratification allows you to manage the stratification boundary 

definitions to analyze change over time if your project will be reassessed in the 

future. For example, a land use category that is agricultural in an initial study may 

be developed in the future and reclassified as residential or commercial. 

Although post-stratification allows for greater flexibility, one disadvantage is that 

estimates may not be as accurate as a pre-stratified project where plot quantity is 

predetermined based on existing land types and desired objectives. 

 

How big will your plots be? 

 

The standard plot size for an Eco analysis is a 0.1-acre circular plot with radius of 37.2 feet. If 

necessary, smaller or larger plots can be used – for instance, if you are analyzing a small area 

in which 0.1-acre plots would overlap. 

 

How many plots will you inventory? 

 

As a general rule, 200 plots (one-tenth acre each) in a stratified random sample (with at least 20 

plots per stratum) will yield a standard error of about 10% for an estimate of the entire city. As 

the number of plots increases, the standard error decreases and you can be more confident in 

the estimate for the population. The graph below provides a rough estimate of how the standard 

error of the total number of trees in a city changes based on the number of plots sampled. Note 

how for the first 100 plots, the standard error drops more rapidly than for the second 100 plots, 

although the standard error continues to drop with increased sample size. 

 

Keep in mind, however, that as the number of plots increases, so does the time and cost of field 

data collection. A crew of two people can typically measure 200 plots in one summer for a city 

with about 20% tree cover. The actual number of plots to be measured differs based on many 

factors, including the size of the city and tree cover. 

 

 

 

We recommend adding an extra 5-10% to your final number of plots.  

These extra plots can serve as replacements where another plot is 

inaccessible. 

 

Tip 
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So you’ve answered all of the questions in Phase I and are ready to set up your Eco project… 

 

Use Table 1 to help you through Phase II. Read the questions in the table, choose the answer 

that applies to your project, and then follow the directions. This will help guide you to the steps 

that are relevant to your project. 

 
Table 1—Guide to Next Steps 

Questions Answers Directions 

1. What are the boundaries 
of your study area? 

1a. My study area is located in the U.S., 
Australia, Canada, or the UK. 

Continue to Question #2. 

1b. My study area is not located in the 
U.S., Australia, Canada, or the UK. 

Read about The Data Gathering Step 

below, then go to Question #2 of this 
table. 

2. What type of inventory 
will you do? 

2a. Complete inventory – I will sample 
all of the trees in my study area. 

Continue to Question #3. 

2b. Plot-based sample inventory – I will 
sample the trees on plots distributed 
throughout my study area. 

Skip to Question #4. 

3. Do you have an existing 
inventory? 

3a. Yes – I will be importing an existing 
inventory. 

Go to Phase IV of this manual. 

3b. No – I need to collect field data. Go to Phase III of this manual. 

4. Will you stratify your 
sample? 

4a. No – I am going to do a simple 
random sample. 

Read about The Sample Creation 
Step below, then go to Phase III of 

this manual. 

4b. Yes – I am going to do a stratified 
random sample and pre-stratify my 
project. 

Read about The Sample Creation 
Step, then go to Phase III of this 

manual. 

4c. Yes – I am going to do a stratified 
random sample and post-stratify my 
project. 

Read about The Sample Creation 
Step, then go to Phase III of this 

manual. 

5. How big will your plots 
be? 

(as specified) 
Use this information in the Preparing 
for the Field section of Phase III. 

6. How many plots will you 
inventory? 

(as specified) 
Use this information in The Sample 
Creation Step below. 

   

Phase II: Setting Up Your Project 

 Guide to Next Steps 
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Datasets that are used in conjunction with the collected field data include: 

 

 Species information 

 Location information 

 Precipitation data 

 Pollution data 

 

These data are already incorporated in Eco for study areas in the U.S., Australia, Canada, and 

the UK. Outside of these countries, you will need to provide your own additional data and submit 

it using the i-Tree Database application.  

 

i-Tree Database provides two functions. Users may choose to do one or both of the following 

while working with the tool: 

 

1  View the Species or Location databases, or 

 

2 Add Species, Location, Precipitation, or Pollution data to the databases. 

 

The option to view the Species or Location databases allows users to search the data used by 

the i-Tree applications. Users can see what species and locations are currently available for 

modeling. For new projects, users should check if their location and species of interest are 

already in the data. Identifying missing data will help inform decisions to add data to the 

databases. 

To get started, go to i-Tree Database at: http://www.itreetools.org/database. View the Species 

and Location databases in turn. Note if your project location and desired tree and shrub species 

are already in the database. 

 

 

 

 

 

 The Data Gathering Step 

 

 

Weather data is also used in i-Tree Eco and is available globally from the 

National Climatic Data Center (NCDC). All datasets from the NCDC with 

sufficient weather data have been incorporated in i-Tree Eco v6.0. 

Currently, users will select from the available weather stations directly in 

the application and are not able to submit their own weather data. 

Tip 

http://www.itreetools.org/database
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To view available species: 

1 Click on View Database at the top of the i-Tree Database webpage. 

2 Select Species from the drop-down list. 

3 Choose one of the following from the Search by drop-down: 

a Scientific Name 

b Common Name 

4 Enter the name of the species that you are trying to find based on your selection in the 

Search by drop-down (i.e., scientific or common name). 

5 Click Go. 

6 The species that match your search will be listed below the search box. 

7 Click Clear to discard the name that you entered and start over. 

 

If you are having difficulty finding a species, try searching by both scientific and common name 

or entering only part of the name in the search box. 

 

To view available locations: 

1 Click on View Database at the top of the i-Tree Database webpage. 

2 Select Location from the drop-down list. 

3 Define a search area by: 

a Selecting a nation from the Search by drop-down. 

b Selecting a more precise area from the list, if additional drop-down menus 

appear. 

4 Click Go. 

5 All of the available locations in your designated search area will be listed below the 

search box. 

6 Click Clear to discard the search area that you defined in the search box and start over. 

 

 

 

 

 

 

 

Refer to i-Tree Database’s “How to Use” text by going to Menu > Help at 

the top of the webpage. 

Tip 

 

 

If you see incomplete or erroneous data in either the species or location 

information, let the i-Tree Team know! Go to the Feedback menu at the top 

of the i-Tree Database webpage and click on Comments. 

Tip 
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Species Information 

 

The Species database includes species information for more than 6,500 tree and shrub species. 

Though adding new species for i-Tree Eco is optional, it is necessary for your analysis if any 

species in your local area are not already included. 

 

By viewing the database, as described above, you can identify any missing tree or shrub 

species. To make those species available in Eco, collect the necessary information for those 

species and submit it using i-Tree Database. The required and optional species information are 

described in the Eco Guide to International Projects. 

 

Location Information 

 

 

The Location database includes location information for places in the U.S., Australia, Canada, 

and the UK and is expanding internationally. When you designed your Eco project, you should 

have decided on the location and boundaries of your study area. By viewing the database, as 

described above, you can identify if your location is already available in Eco. If it is, you do not 

need to submit any location information. Your Eco project can be run directly in Eco.  

 

 

 

If your location is already available in Eco, you will not need to submit any 

location information. However, be sure to read about the species information, 

precipitation data, pollution data, and valuation data in this guide as you may 

still want to submit that data.  

Caution 

 
! 

 

 

If you determine that you will need to submit additional data using i-Tree 

Database, consider doing that before you collect your field data. Data 

submitted in i-Tree Database will need to be vetted by the U.S. Forest 

Service before it can be made available in Eco. This will take some time. 

Tip 

 

 

Location information is required to run Eco in any location not yet in the 

database. 

Tip 

https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InternationalProjects.pdf
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To make the location for your project available in Eco, collect the necessary information for that 

location and submit it using i-Tree Database. The required and optional location information are 

described in the Eco Guide to International Projects. 

 

Precipitation Data 

 

 

Internationally, precipitation data is often insufficient or absent from the weather data available 

in Eco. To supplement Eco’s existing weather data with hourly precipitation data for your 

location, collect the necessary information for the precipitation data and submit it using i-Tree 

Database. More information about providing and formatting precipitation data is available in the 

Eco Guide to International Projects. 

 

Pollution Data 

 

 

Hourly air quality data can be submitted for particulate matter less than 2.5 microns (PM2.5), 

carbon monoxide (CO), ozone (O3), nitrogen dioxide (NO2), and sulfur dioxide (SO2). Users may 

choose to provide hourly data for some or all of these pollutants. Pollutants for which no hourly 

data are submitted will be excluded from the analysis. To provide local pollution data for your 

location, collect the necessary information for the pollution data and submit it using i-Tree 

Database. More information about providing and formatting pollution data is available in the Eco 

Guide to International Projects. 

 

 

 

 

 

 

 

Precipitation data is required for avoided runoff modeling and strongly 

recommended for pollution removal. Without precipitation data, the i-Tree Eco 

model cannot estimate avoided runoff. Pollution removal estimates for PM2.5 

also use precipitation data and without the data the model will likely 

overestimate PM2.5 removal. 

Tip 

 

 

Air quality data is required to run the pollution model. Without this data, 

pollution removal estimates will not be included in your results. 

Tip 

https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InternationalProjects.pdf
https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InternationalProjects.pdf
https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InternationalProjects.pdf
https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InternationalProjects.pdf
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Valuation Data 

 

International users are also encouraged to provide local valuation data. Providing your own 

benefit prices allows users to localize their results. i-Tree Eco uses values from the scientific 

literature to estimate the economic value associated with tree benefits. Default values currently 

estimated are: 

 

 Carbon – based on the U.S. Social Cost of Carbon (SCC) 

 

 Avoided runoff – U.S. national average costs of stormwater control 

 

 Pollution removal – based on U.S. median externality values for carbon monoxide, 

nitrogen dioxide, sulfur dioxide, particulate matter less than 2.5 microns, and ozone 

removal 

 

 Energy – U.S. national average cost of electricity and fuels (e.g., heating oil, propane, 

natural gas) 

 

You can provide your own valuation data if you would like to localize your benefit estimates. If 

you do not provide your own valuation data, the default values will be used and converted to the 

local currency with a user-defined exchange rate. Unlike species, location, precipitation, and 

pollution data which are submitted in i-Tree Database, valuation data are entered directly in the 

i-Tree Eco application. By entering the data directly in Eco, it will be used for your project, but it 

will not be added to the databases. Read about adding valuation data in Eco under Phase IV: 

Working with Eco > Navigating the User Interface. 

 

 

If you have decided to do a plot-based sample project, then you will need to create your sample. 

This step will walk you through that process.  

 

 

 The Sample Creation Step 

 

 

The pollutant particulate matter less than 10 microns (PM10) is no longer 

included because i-Tree Eco v6.0 analyzes particulate matter less than 2.5 

microns (PM2.5) which is a subset of PM10. PM2.5 is generally more relevant in 

discussions concerning air pollution effects on human health. 

Caution 

 
! 
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Randomization 

 

There are many ways that you can randomly distribute plots throughout your study area, 

whether you are working with a stratified or unstratified sample. Again, your decision should be 

based on the objectives of your study and the resources available to create the layout. Some 

Eco users collaborate with local universities or government agencies for assistance to create 

random plot layouts for their projects. Three randomization methods are as follows: 

 

 

Random:  

For an unstratified or post-stratified sample, plots are laid randomly within the boundaries of the 

entire study area. For a pre-stratified sample, plots are laid randomly within the boundaries of 

each individual predetermined stratum. 

 

Fixed Grid: 

First, random plots are created by laying out a fixed grid of points equidistant over the entire 

project area. Once the grid points have been laid out, they are numbered. 

 

For an unstratified or post-stratified sample, plots are selected for the entire study area by 

choosing points from the grid using a random number generator, which can be found online or 

within software tools such as Excel. For a pre-stratified sample, plots are selected the same 

way, but for each predetermined stratum. 

 

A potential disadvantage of this method, however, may occur if the grid unintentionally coincides 

with an existing city street grid. In that case, many plots may fall on similar land uses, which 

may not be desirable. 

 

Randomized grid:  

In this method, an evenly spaced grid is laid over the study area. Then, plot points are selected 

randomly within each cell, which allows for a more even distribution of points throughout your 

study area with a greater degree of randomness than using a fixed grid. 

 

Random Fixed Grid Randomized Grid 
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One advantage of the randomized grid is that it allows for multiple post-stratification schemes 

because plots are more evenly distributed. 

 

Sample Creation Methods 

 

Once you have designed your sample and made the necessary decisions about stratification, 

plot size, and number of plots, there are multiple methods available to help you create your plot 

sample. You can use any method you like, including paper maps and pencil, as long as it 

follows random sampling conventions.  

 

Eco offers a random plot generator that allows you to create your sample right in the application 

itself. The plot generator works with Google Maps and utilizes study area boundaries that can 

be drawn by the user or supplied from an ESRI ArcGIS shapefile. This method can be used 

whether you have decided to stratify your sample or not. However, in the Google Maps Plot 

Generator, plots are distributed randomly and cannot be distributed on a fixed grid or 

randomized grid. 

 

Eco plots can also be created in other programs and loaded into the application. In this case, 

you could use ESRI’s ArcGIS software to generate your plots. The end result will be three files 

to load into Eco during project set up to create a plot list for your project configuration. 

 

How you choose to create your sample ultimately depends on your randomization method, 

decisions about stratification, and available resources. For example, nearly all sample designs 

can be created using GIS, but the software can be expensive. The random type of random plot 

distribution is typically done by using Eco’s Google Maps Plot Generator or with the aid of a GIS 

system. The fixed grid type of random plot distribution can be done manually on a map or by 

using GIS. The randomized grid type of random plot distribution would most likely require GIS. 

 

 

 

 

Look at the Eco Guide to Unstratified Samples for directions on how to 

create an unstratified random sample of i-Tree Eco plots using Eco’s Google 

Maps Plot Generator or ESRI’s AcrGIS software. 

Eco Guide  

 

 

Look at the Eco Guide to Pre-stratified Samples for directions on how to 

create a pre-stratified random sample of i-Tree Eco plots using Eco’s Google 

Maps Plot Generator or ESRI’s AcrGIS software. 

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_UnstratifiedSamples.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_PreStratifiedSamples.pdf
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Look at the Eco Guide to Post-stratified Samples for directions on how to 

create a post-stratified random sample of i-Tree Eco plots using Eco’s manual 

plot creation function. 

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_PostStratifiedSamples.pdf
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Required Variables 

 

Deciding what data you will collect for your trees is an important step in planning your Eco 

project. The following two data variables must be collected for each tree (for complete and plot-

based sample inventories): 

 

 Species: Identify and record the species and genus names of each tree assessed. 

 

 Diameter at breast height (DBH): Measure and record the tree stem diameter at breast 

height (4.5 feet above the ground) for each tree. 

  

 

In addition, the following two data variables must be collected for each plot (for plot-based 

sample inventories only): 

 

 Percent measured: Identify the amount of the plot that the field crew is able to access 

and measure, either directly or by estimation, for each plot. 

 

 Percent tree cover: Identify the amount of the plot covered by tree canopy (in percent) 

for each plot. 

 

 

 

Phase III: Collecting Your Field Data 

 Choosing Your Data 

 

 

i-Tree Eco requires users to collect two tree measurements. While this 

approach allows users with limited existing inventories to run the model, it 

also has substantial limitations. The accuracy of ecosystem service 

estimates can be improved significantly by providing additional optional tree 

measurements. 

 

Please read more about these data limitations in the Eco Guide to Data 

Limitations. 

Caution 

 
! 

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_DataLimitations.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_DataLimitations.pdf
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Supplemental Analyses 

 

i-Tree Eco provides data on the structure, function, and benefits of your urban forest, including: 

 Number of trees 

 Species composition 

 Leaf area and biomass 

 Pollution removal and value 

 Carbon storage, sequestration, and value 

 Avoided runoff and value 

 Volatile organic compound emissions 

 Oxygen production 

 Ultraviolet (UV) effects 

 

 

There are several supplemental analyses that you can include in your custom Eco project. 

Review the following descriptions to help you decide which analyses are relevant to the goals of 

your project. 

 

Energy (available for complete and plot-based sample inventories): 

Trees located near buildings can affect the amount of energy used to heat or cool the structure 

by reducing air temperatures, blocking wind, and providing shade. If you would like to assess 

the effects your urban forest is having on energy consumption, you will need to collect 

information related to nearby buildings (i.e., distance and direction from trees). (Note: Energy 

effects are only calculated for residential buildings). 

 

Wildlife (available for plot-based sample inventories): 

Eco estimates the suitability of an area to sustain the populations of nine different bird species 

based on the habitat features that relate to and influence the patterns of abundance for each 

species. These estimates are based on the species’ range, local forest structure, and tree, 

shrub, and ground cover provided by the study area. To assess wildlife suitability, percent shrub 

cover and ground cover composition must be collected. Additional tree characteristics are highly 

recommended for better estimates (consult Table 3 below). 

 

Forecast (available for complete and plot-based sample inventories): 

The Forecast model uses structural estimates generated by Eco along with growth and mortality 

rates to estimate what your urban forest will look like in the future. If you would like to explore 

your future urban forest, additional information are recommended (consult Table 3 and 4 below).  

 

 

Supplemental analyses will require you to collect more tree data than the two 

variables described above (species and DBH). Consult Table 3 and Table 4 in 

the section that follows to guide your decision here. 

Caution 

 
! 
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Shrubs (available for plot-based sample inventories): 

Eco primarily analyzes the trees in your study area, but shrubs are another important resource 

and provide numerous benefits. If you would like to analyze the shrubs in your study area, you 

will need to collect information on the species, height, and cover of shrubs within the plots. 

 
Plantable space (available for plot-based sample inventories): 

If you would like to estimate the available planting space for your area, you will need to collect 

information on the fraction of each plot that is plantable. 

 

Pests (IPED) (available for complete and plot-based sample inventories): 

The i-Tree Pest Detection protocol (http://www.itreetools.org/iped/index.php) allows you to 
document signs and symptoms of tree pests and diseases as part of your Eco project. To 
complete this module, you will need to record information related to tree health in the field. 

 
Cover under canopy (available for plot-based sample inventories):  

i-Tree Hydro is an application in the i-Tree suite that assesses the effects of urban tree cover 

and impervious surfaces on hourly stream flow and water quality for a defined study area. If you 

plan to conduct an analysis using Hydro, you will be asked to supply data regarding the average 

percentage of impervious surface and shrub cover under the driplines of trees in your area. As 

this information can be hard to come by, we have made it possible to collect these data during 

an Eco project. Keep in mind, however, that the project boundary of your Eco analysis should 

match the area (e.g., watershed or community) you will study in Hydro for this to be valuable.  

  

Data Collection Options 

 

There are a number of optional data variables that can be collected. Each variable you collect 

adds depth to the analysis but also adds to the cost of the project. Pay attention to which 

variables are required by the supplemental analyses that you choose to do. 

 

 

 

 

 

 

 

The Pest Detection protocol is independent of the existing Eco pest 

susceptibility report. The susceptibility report does not reflect field-collected 

data about actual risks and harm, but rather calculates the damage that a 

potential outbreak could have based on species diversity in your population. 

This susceptibility report will continue to be fully functional if you choose not to 

collect the supplemental pest detection data. 

 

Tip 

http://www.itreetools.org/iped/index.php
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Table 3—Data Collection for Plot-Based Sample Inventory Projects 

The Description column provides more information about each data variable. The extra 

model components shown in the right-hand columns require certain optional data to be 

collected. Data that are required for each extra model component are designated by an “X”.  

Data that are recommended for each extra model component are designated by an “R”. 
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Data Variables Description 

Survey information 

Survey date Date on which survey takes place        

Crew Crew that conducts survey        

Plot information 

Plot ID ID number of plot (must be a unique identifier)        

Plot address 
Street address of plot or notes for locating plots in areas 
without street addresses 

       

Stake (y/n) 
Whether location of permanent plot has been marked by a 
permanent identifier 

       

GPS coordinates Longitude and latitude of plot center        

Offset point 
Reference point to serve as a tree measurement point if the 
plot center is inaccessible 

       

Photo ID ID number of photo associated with plot        

Plot sketch 
Sketch of plot depicting distance and direction of plot center 
to reference objects and/or location of fixed objects relative 
to plot center 

       

Plot contact information Name and phone number of plot contact person        

Percent measured 
Amount of the plot that the field crew is able to access and 
measure (in percent) 

       

Percent tree cover Amount of the plot covered by tree canopy (in percent)  X      

Percent shrub cover Amount of the plot covered by shrub canopy (in percent)  X   X   

Percent plantable space 

Amount of the plot area that is plantable for trees (i.e., 
plantable soil that is not under tree canopy or other 
overhead restrictions and where tree planting/establishment 
would not be prohibited due to land use, such as a baseball 
field) 

     X  

Reference 
objects 

Object type 
Visible landmarks, such as a stop sign or permanent 
structure, that are seen when standing at plot center 

       

Direction Direction from the plot center to the reference object        

Distance Distance from the plot center to the reference object        

DBH 
Stem diameter measured at breast height (DBH) if the 
reference object is a tree 

       

Land use 
Actual land use Land use types that are seen in the field        

Percent of plot Amount of the plot area covered by each land use        

Ground 
cover 

Ground cover Ground cover types that are seen in the field R X      

Percent of plot Amount of the plot area covered by each ground cover R X      

Shrubs 

Species Name of shrub species     X   

Height 
Average height of shrub group (i.e., mass of shrubs of the 
same species) 

    X   

Percent of area 
Amount of the shrub area in the plot covered by each shrub 
group 

    X   

Percent 
missing 

Percent of the shrub group volume that is missing  (i.e., not 
occupied by leaves) 

    X   
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Table 3—continued 

The Description column provides more information about each data variable. The extra 

model components shown in the right-hand columns require certain optional data to be 

collected. Data that are required for each extra model component are designated by an “X”.  

Data that are recommended for each extra model component are designated by an “R”. 
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Data Variables Description 

Tree information 

Tree ID ID number of tree (must be a unique identifier within a plot)        

Direction to plot center Direction from plot center to the tree        

Distance to plot center Distance from plot center to the tree        

Land use Land use type in which tree is located  R      

Species Identify species and genus names  X   X    

Street tree/non-street tree Identify whether tree is a street tree or not (Y/N)        

Public/private 
Classification of each tree as city managed (public) or not 
(private) 

       

Status Status of tree as planted or self-seeded        

Total tree height Height from the ground to the top (alive or dead) of the tree R R  R    

Crown 
size 

Height to live top Height from the ground to the live top of the tree        

Height to crown 
base 

Height from the ground to the base of the live crown        

Crown width 
Width of the crown in two directions: north-south and east-
west 

       

Percent crown 
missing 

Percent of the crown volume that is not occupied by 
branches and leaves 

R       

Crown health 
Tree crown health estimated as condition or dieback (i.e., 
dead branches) of the crown 

 R  R    

Crown light exposure 
Number of sides of the tree receiving sunlight from above 
(maximum of 5) 

   R    

Cover 
under 
canopy 

Percent 
impervious 

Percent of the area beneath the drip line of the tree that is 
impervious 

      X 

Percent shrub 
Percent of the area beneath the drip line of the tree that is 
shrub 

      X 

DBH Diameter of tree stem at breast height   X  X    

Energy 
Direction Direction from tree to the closest part of the building X       

Distance Distance from tree to the closest part of the building X       

Management information 

Maintenance recommended 
User defined general maintenance recommendations (e.g., 
routine prune) for the tree 

       

Maintenance task 
User defined priority maintenance tasks (e.g., pest 
treatment) for the tree 

       

Sidewalk conflict 
Extent of damage to sidewalks from nearby trees defined 
by user 

       

Utility conflict 
User defined potential or existing conflicts between tree 
branches and overhead utility lines 

       

Pests 
(IPED) 

Signs and 
symptoms of 
tree stress 

Absence or presence of signs and symptoms of dieback, 
epicormic sprouts, wilted foliaged, environmental stress, or 
human stress 

  X     

Signs and 
symptoms of 
foliage/twigs 

Absence or presence of signs and symptoms of defoliation, 
discolored foliage, abnormal foliage, or insect signs and 
extent of foliage affected 

  X     

Signs and 
symptoms of 
branches/bole 

Absence or presence of signs and symptoms of insects or 
diseases on the branches/bole and location of signs or 
symptoms 

  X     
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Table 4—Data Collection for Complete Inventory Projects 

The Description column provides more information about each data variable. The extra 

model components shown in the right-hand columns require certain optional data to be 

collected. Data that are required for each extra model component are designated by an “X”.  

Data that are recommended for each extra model component are designated by an “R”. 
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Data Variables Description 

Survey information 

Survey date Date on which survey takes place    

Crew Crew that conducts survey    

Tree information 

Tree ID ID number of tree (must be a unique identifier within a plot)    

GPS coordinates Longitude and latitude of tree location    

Strata 
Sub-units by which trees are divided for analysis (e.g., land 
use, zone) 

   

Land use Land use type in which tree is located    

Species Identify species and genus names X  X 

Street tree/non-street tree Identify whether tree is a street tree or not (Y/N)    

Public/private 
Classification of each tree as city managed (public) or not 
(private) 

   

Status Status of tree as planted or self-seeded    

DBH Diameter of tree stem at breast height   X 

Total tree height Height from the ground to the top (alive or dead) of the tree R  R 

Crown 
size 

Height to live top Height from the ground to the live top of the tree    

Height to crown 
base 

Height from the ground to the base of the live crown    

Crown width 
Width of the crown in two directions: north-south and east-
west 

   

Percent crown 
missing 

Percent of the crown volume that is not occupied by 
branches and leaves 

R   

Crown health 
Tree crown health estimated as condition or dieback (i.e., 
dead branches) of the crown 

  R 

Crown light exposure 
Number of sides of the tree receiving sunlight from above 
(maximum of 5) 

  R 

Energy 

Direction Direction from tree to the closest part of the building X   

Distance 
Shortest distance from tree to the closest part of the 
building 

X   

Management information 

Maintenance recommended Necessity of routine or immediate maintenance for the tree    

Maintenance task Necessity of priority tasks (e.g., pest treatment) for the tree    

Sidewalk conflict Extent of damage to sidewalks from nearby trees    

Utility conflict 
Potential or existing conflicts between tree branches and 
overhead utility lines    

Pests 
(IPED) 

Signs and 
symptoms of tree 
stress 

Absence or presence of signs and symptoms of dieback, 
epicormic sprouts, wilted foliaged, environmental stress, or 
human stress 

 X  

Signs and 
symptoms of 
foliage/twigs 

Absence or presence of signs and symptoms of defoliation, 
discolored foliage, abnormal foliage, or insect signs and 
extent of foliage affected 

 X  

Signs and 
symptoms of 
branches/bole 

Absence or presence of signs and symptoms of insects or 
diseases on the branches/bole and location of signs or 
symptoms 

 X  
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Collecting Strata for Complete Inventories 

 

One of the variables described in Table 4 is strata. This data can be collected for complete 

inventory projects and used to subdivide the trees in your study area into different strata or 

zones, such as land uses and neighborhoods. 

 

For some studies, stratifying (subdividing) the trees based on zones can help clarify differences 

across the area. For example, a stratified complete inventory with many trees may allow for 

comparison between land use types or neighborhoods. The decision to stratify should be based 

on your current and future project objectives and your available resources. 

 

 

 

We strongly recommend collecting the following tree information, which will 

improve the accuracy of your Eco estimates! See the Eco Guide to Data 

Limitations for more information. 

 Actual land use 

 Total tree height 

 Height to live top 

 Height to crown base 

 Crown width 

 Percent crown missing 

 Crown light exposure 

 Crown health (condition or percent dieback) 

Tip 

 

 

Stratification is handled differently for plot-based sample projects. If you are 

doing a plot-based sample project and are interested in stratifying your 

study area, please read more about it in the Phase I > Plot-Based Sample 

Inventory section. 

Tip 

 

 

Look at the Eco Guide to Stratifying a Complete Inventory for directions on 

how to pre-stratify or post-stratify your complete inventory project. 

Eco Guide  

https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_DataLimitations.pdf
https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_DataLimitations.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_StratifyingCompleteInventory.pdf
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When you are ready to go out into the field and collect your tree data, you have several different 

options for recording your data. Review the descriptions and advantages/disadvantages of each 

before deciding how you will record your data in the field. 

 

Using the Mobile Data Collector 

 

i-Tree Eco offers a mobile data collector for collecting data in the field. Projects can be 

conducted using a web-enabled mobile device. This functionality is not an app that you have to 

download from a store; it’s a web-based inventory data collection form. This means that the only 

requirement is a device with a web browser that is HTML5 compatible. Compatible browsers 

include most recent versions of Chrome and Firefox (for Android phones and tablets), Safari (for 

iPhones and iPads), and to a lesser extent, Internet Explorer 9 and 10 (for Windows phones and 

tables). IE is limited by its ability to cache data offline – users must remain “connected” while 

collecting field data. For this reason, if you are using IE, you should be prepared to transfer your 

data from your mobile device to the server frequently and recognize that a lost data connection 

means all data since your last submission will be lost. 

 

Advantages 

 Easy data importing to Eco 

 

Disadvantages 

 Requires additional technology in the field – must have a web-enabled mobile device, 

such as a smartphone or tablet 

 

Using Paper Forms 

 

i-Tree Eco offers paper forms for collecting data in the field which provides a simple, 

inexpensive method of recording data. 

 

Advantages 

 Easy to use 

 Deciding How to Record Your Data 

 

 

For a running list of compatible devices, see the i-Tree forum at 

forum.itreetools.org or the system requirements document at 

www.itreetools.org/resources/manuals.php. 

Tip 

http://forums.itreetools.org/
http://www.itreetools.org/resources/manuals.php
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 Does not require additional technology in the field – just paper and pen or pencil! 

 

Disadvantages 

 Requires manual data entry for bringing data into Eco 

 

Additional Options 

 

PDAs 

Past versions of Eco supported the use of a PDA for data collection, which worked seamlessly 

with the desktop application. With this method of recording data, you could use the PDA 

application with handheld devices running Windows Mobile 5.0-6.5 operating system, such as 

PDAs, smartphones, Trimble dataloggers, etc. 

 

Though Eco v6.0 does not support the use of PDAs for data collection, Eco v5.0 is being offered 

as a legacy version, which allows users to make use of the PDA application.  

 

 
Non-i-Tree Inventory Platforms 

If your community lacks funding to support the use of mobile devices or PDAs or you simply 

prefer to use an alternative method, that’s no problem. Inventories can be conducted using 

paper forms or spreadsheets of your own design, proprietary inventory tools, etc. The desktop 

Eco application includes a user-friendly input form to simplify the data entry process. Exploring 

the manual data entry process in the application may help guide you if you decide to use a non-

i-Tree platform. 

 
 
 
 

 

 

Look at the Eco Guide to Collecting Data with a PDA for details about using 

Eco v5.0 and PDAs for data collection. Also, refer to the Eco v5.0 User’s 

Manual available at www.itreetools.org/resources/manuals.php for directions 

on using PDAs in the field. 

 

Eco Guide  

 

 

Other i-Tree users have developed modifiable data sheets for data 

collection that are available at www.itreetools.org under the Eco resources 

section of Resources > Archives. 

Tip 

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_CollectingDatawithPDA.pdf
http://www.itreetools.org/resources/manuals.php
http://www.itreetools.org/
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Your final step before you are ready to collect your field data is to set up your data collection 

materials. If you are doing a plot-based sample project, read the Mapping Field Plots section 

below. Otherwise, skip ahead to Getting Started in Eco. 

 

Mapping Field Plots 

 

For sample inventory projects, one of the final steps before data collection can begin is to create 

maps identifying the physical location of the plots. If the random plots were created in GIS, the 

plot shapefile can be overlaid on digital aerial photos of the study area to aid crews in locating 

plots and plot centers on the ground. 

 

Similarly, if you created your random points using the Google Maps Plot Generator, the points 

can be incorporated into GIS and overlaid on digital aerial photos. In addition, detailed plot 

maps can be very useful in aiding crews in estimating plot cover percentages. Examples of plot 

maps can be found at www.itreetools.org under Resources > Archives > Eco Project 

Planning & Management Resources. If digital photos are not available or if the plots were 

created manually, they can be located on a digital land use or road map or on paper maps. Plot 

centers and plot boundaries should be identified. 

 

Getting Started in Eco 

 

If you have decided to use the Eco mobile data collector or paper forms, we recommend you 

proceed as follows: 

 

Begin working with Eco to create a new project. Click on your computer’s Start button > (All) 

Programs > i-Tree > i-Tree Eco v6. 

 

To start a new project: 

1 Click File > New Project. 

2 Define the project type by choosing from the drop-down list. 

 Preparing for the Field 

 

 

Directions for creating your random sample using the Google Maps Plot 

Generator or ESRI’s GIS are available in the following Eco Guides: 

 Eco Guide to Unstratified Samples 

 Eco Guide to Pre-stratified Samples 

Eco Guide  

http://www.itreetools.org/
https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_UnstratifiedSamples.pdf
https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_PreStratifiedSamples.pdf
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3 Browse to the folder where you would like to save your project, enter a file name, and 

click Save. 

 

To configure your project: 

1 Click on the Project Configuration tab. 

2 Click on the Project Definition function. 

3 Work through the Project Settings, Location, and Data Collection Options tabs from 

left to right. 

4 Close the Project Definition function when you are finished by clicking on the OK 

button in the upper right-hand corner to save your settings. 

5 Work from left to right through the Project Configuration tab to provide additional 

information for the functions that are relevant to your project. 

 

Preparing Paper Forms 

 

If you have decided to collect your data using Eco’s paper form and you have already 

configured your project (as described in Getting Started with Eco above): 

 

1 Click on the Data tab. 

2 Click on the Paper Form function. 

 

Links for the various paper data collection forms will appear in the action panel to the right. Click 

on a link to launch the form in your web browser. The following types of forms are available: 

 For users doing a complete inventory project, there is a single data sheet in xlsx format 

for recording tree data. 

 For users doing a plot-based sample project, there are two data sheets. One in xlsx 

format for recording tree data and another in doc format for recording plot data. 

 For users doing the supplemental pest (IPED) analysis, there is a single data sheet in 

xlsx format for recording pest observations. 

 

 

Use the information in Phase IV > Navigating the User Interface to help 

you navigate through the functions in the Project Configuration tab. 

Tip 

 

 

While working in Eco, use the on-screen help text in the panel on the left-

hand side of the window. This help text will provide step-by-step directions 

for using each button and function. 

Tip 
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Preparing the Mobile Data Collector 

 

If you have decided to collect your data using Eco’s mobile data collector and you have already 

configured your project (as described in Getting Started with Eco above): 

 
1 Click on the Data tab. 

2 Click on the Submit to Mobile function. 

3 Enter and confirm your email address in the spaces provided. 

4 Enter and confirm your password in the space provided. 

5 Check the box next to the record(s) that you would like to submit. 

6 Click Submit Project. 

7 Check the email account that you provided for instructions on accessing the mobile data 

collector for your project. 

 

 
By this point in the Eco project phases, you should have: 

 Chosen the data variables that you will collect in the field 

 Decided how you will collect and record your field data 

 Designed and created your plot sample (for plot-based sample projects only)  

 Prepared your data collection materials to go out into the field 

 

Now it’s time to actually collect your field data! Use Eco’s Field Guide to guide you as you 

collect and record your data. 

  

 Going Out in the Field 

 

 

Before you can start working with the mobile data collector, you must submit 

your project configuration. If you do not submit your project, you will not be 

able to access the web form from your mobile device. 

Caution 

 
! 

https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6_FieldManual.pdf
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Throughout this section of the manual, we will refer to certain components of the i-Tree Eco 

application. Here’s a guide to show you what the components of the Eco window look like. See 

the Glossary for more details! 

 

 

 

 

 

 

 

 

 

 

 

Phase IV: Working with Eco 

 Getting to Know Eco 

Tabs 

Select one of the tabs on the ribbon to 

display the buttons and functions available. 

Window display 

Use these buttons to 

           minimize; 

           restore down/maximize; or 

           close the window. 

File menu 

Create new, open, save, and manage your 

Eco projects here. 

Need help? 

Use the on-screen help text in this panel 

as guidance through the process of 

creating, editing, and viewing your Eco 

project and results. 

 
Use this button to 

           auto hide. 

What is the action panel? 

The action panel is this part of the window where 

you input and edit your project settings and data, 

as well as view reports. When you click on a 

button or function in the ribbon, the feature will 

be available here. 
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The Eco application is so versatile that rather than provide step-by-step directions we have 

chosen to explain what you can do in each tab and function and why that might be important to 

you. Review the information in this section to help you navigate through the application’s user 

interface. 

 

  

 Navigating the User Interface 

 

 

While working in Eco, use the on-screen help text in the panel on the left-

hand side of the window. This help text will provide step-by-step directions 

for using each button and function. 

Tip 

 

 

This is a complete list of tabs, functions, and buttons that are available for the 

Eco user interface. Depending on whether you are doing a plot-based sample 

inventory or a complete inventory, certain functions may not appear or may 

be “greyed out.” Do not worry about the “missing” functions – they are not 

available because they are not relevant to your specific project. 

Caution 

 
! 

 

 

i-Tree Eco provides example projects that you can look at to explore the 

application before working with your own project. Check out the Eco Guide to 

Exploring Example Projects for more details.  

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_ExploringExampleProjects.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_ExploringExampleProjects.pdf
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File Menu 

 

New Project 

Description: This menu option allows you to create a new Eco project. 

 

Open Project 

Description: This menu option allows you to open an existing Eco project. 

 

Open Example Project 

Description: This menu option allows you to open one of Eco’s example projects.  

 

Why It’s Important: i-Tree Eco provides example complete inventory and plot-based 

inventory projects that you can view to become more familiar with the Eco application. 

 

Save Project (Automatic). 

Description: This option is disabled, but included in the menu to indicate that your Eco 

project is automatically saved as edits are made. 

 

Save a Copy 

Description: This menu option allows you to save your open project under a new name.  

 

Why It’s Important: This feature is especially useful if you want to view the same project 

in different ways. For example, let’s say you decide to post-stratify your results. You can 

try stratifying your plots several different ways and save your Eco project each time you 

stratify using the Save a Copy feature. 

 

Pack Project 

Description: This menu option allows you to put all of your project materials into a single 

compressed folder that saves storage space and can be shared easily.  

 

Close Project 

Description: This menu option allows you to close your open project without closing the 

Eco application. 

 

Exit 

Description: This menu option allows you to close the Eco application. 
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Project Configuration 

 

On this tab, you can set up your new i-Tree Eco project, make changes, or view the settings that 

you provided for an existing project. 

 

Project Definition 

 

Project Definition 

Description: In this function, you can identify many of your most important project 

settings, including project name, series, and year, the location of your study area, and 

what data variables you will be collecting. 

 

Why It’s Important: You can’t run Eco without filling out the forms here. Plus, you’ve 

probably spent a lot of time planning and designing your project. All of the decisions that 

you have made to customize your project are used to inform the Eco model and must be 

entered here. 

 

Define Data Fields 

 

Land Use 

Description: In this function, you can view the actual land use classes in your study area. 

Eco provides 13 default land use classes that you can choose to work with or create 

your own list of custom land use classes. 

 

Why It’s Important: If you have decided to collect land use data, which is optional, this 

function is a good place to reference your default options or to customize the list to 

better suit your project. 

 

 

 

 

 

Remember the data collection decisions that you made in Phase III: 

Collecting Your Field Data? This is where that data is specified in the Eco 

application. 

Tip 

 

 

The actual land uses should not be confused with your project strata. If you 

are choosing to stratify by land use, those fields should be defined in the 

Project & Strata Area function. 

Caution 

 
! 
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Ground Cover 

Description: In this function, you can view the ground cover classes in your study area. 

Eco provides 11 default ground cover classes that you can choose to work with or create 

your own list of custom ground cover classes. 

 

Why It’s Important: If you have decided to collect ground cover data, which is optional, 

this function is a good place to reference your default options or to customize the list to 

better suit your project. 

 

Condition 

Description: In this function, you can view Eco’s default condition classes or enter 

custom classes. There are 22 default condition classes that you can choose from when 

you identify condition during data collection out in the field. You can also choose to add 

or edit the list of condition classes using the tools in the Actions group of the ribbon. 

 

Why It’s Important: You don’t actually have to do anything in this function unless you 

want to edit your condition classes. Assessing condition is optional and this function is 

simply a good place to reference if you want a refresher of your default or user-defined 

options. The condition classes that are displayed here will be available in the mobile 

data collector if you collect your field data using a mobile device, as well as in the Data 

tab of the ribbon. 

 

Dieback 

Description: In this function, you can view Eco’s default dieback classes or enter custom 

classes. There are 22 default dieback classes that you can choose from when you 

identify dieback during data collection out in the field. You can also choose to add or edit 

the list of dieback classes using the tools in the Actions group of the ribbon. 

 

Why It’s Important: You don’t actually have to do anything in this function unless you 

want to edit your dieback classes. Assessing dieback is optional and this function is 

simply a good place to reference if you want a refresher of your default or user-defined 

options. The dieback classes that are displayed here will be available in the mobile data 

collector if you collect your field data using a mobile device, as well as in the Data tab of 

the ribbon. 

 

Maintenance 

 

 Maintenance Recommended 

Description: In this function, you can view broad types of recommended maintenance 

that can be specified during data collection in the field. There are six default 

maintenance recommendations (e.g., small tree routine), but we strongly encourage 

users to define maintenance recommendations that are relevant to their project 

goals. 
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Why It’s Important: This data allows you to categorize the management needs of 

your trees. This is where you can view the default classes or customize the list to 

better suit your study area. The recommended maintenance options that are 

displayed here will be available in the mobile data collector if you collect your field 

data using a mobile device, as well as in the Data tab of the ribbon. 

 

 Maintenance Task 

Description: In this function, you can view priority maintenance tasks that can be 

specified during data collection in the field. There are seven default maintenance 

tasks (e.g., crown clearing), but we strongly encourage users to define maintenance 

tasks that are relevant to their project goals using the tools in the Actions group of 

the ribbon. 

 

Why It’s Important: This data allows you to categorize the management needs of 

your trees. This is where you can view the default classes or customize the list to 

better suit your study area. The maintenance task options that are displayed here will 

be available in the mobile data collector if you collect your field data using a mobile 

device, as well as in the Data tab of the ribbon. 

 

 Sidewalk Conflict 

Description: In this function, you can view possible sidewalk conflicts with nearby 

trees that can be recorded during data collection in the field. There are three default 

measurements of sidewalk heaving (e.g., > 1½ inches), but we strongly encourage 

users to define sidewalk conflicts in a way that is relevant to their project goals using 

the tools in the Actions group of the ribbon. 

 

Why It’s Important: This data allows you to categorize the management needs of 

your trees. This is where you can view the default classes or customize the list to 

better suit your study area. The sidewalk conflict classes that are displayed here will 

be available in the mobile data collector if you collect your field data using a mobile 

device, as well as in the Data tab of the ribbon. 

 

 Utility Conflict 

Description: In this function, you can view possible conflicts between tree branches 

and overhead utility lines that can be recorded during data collection in the field. . 

There are three default utility conflicts (e.g., present and conflicting), but we strongly 

encourage users to define utility conflicts in a way that is relevant to their project 

goals using the tools in the Actions group of the ribbon. 

 

Why It’s Important: This data allows you to categorize the management needs of 

your trees. This is where you can view the default classes or customize the list to 

better suit your study area. The utility conflict classes that are displayed here will be 

available in the mobile data collector if you collect your field data using a mobile 

device, as well as in the Data tab of the ribbon. 
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Custom Fields 

Description: In this function, you can define the categories associated with your custom 

fields using the tools in the Actions group of the ribbon. Your custom fields are defined 

in the Project Definition function and would be included in your data collection out in 

the field. 

 

Why It’s Important: This is a great way to customize your Eco project! You may add up 

to three additional custom fields to describe your assessed trees in even more detail. 

The classes that you define here are available in the mobile data collector if you collect 

your field data using a mobile device, as well as in the Data tab of the ribbon. 

 

Define Plots 

 

Load from File 

Description: This function provides one of the methods for identifying your sample plots 

in Eco. Here you can load the three files that are necessary to identify your sample plots. 

 

Why It’s Important: If you have chosen to do a plot-based sample inventory, you will 

need to create a sample and pass that information to the application. More importantly, if 

you have created your sample using ArcGIS software, this function provides the means 

by which to load the files that you created in GIS. 

 

via Google Maps 

Description: This function provides one of the methods for identifying your sample plots 

in Eco. The Google Maps Plot Generator creates your plot sample directly in Eco! 

 

Why It’s Important: If you have chosen to do a plot-based sample inventory, you will 

need to create a sample and pass that information to the application. More importantly, if 

you have chosen to do a simple or stratified random sample, this tool provides an easy 

way to create your sample.  

 

User Defined 

Description: This function provides one of the methods for identifying your sample plots 

in Eco.  

 

Why It’s Important: If you have chosen to do a plot-based sample inventory, you will 

need to create a sample and pass that information to the application. This option allows 

you to define your plot sample manually by simply entering the plot size and number of 

plots that you would like to add to each strata. 
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Project & Strata Area 

 

Project & Strata Area 

Description: In this function, you can add your project or strata area and view or edit the 

strata that you will be using for your project. Stratifying your study area allows you to 

subdivide the study area into smaller units, such as land use classes or political 

boundaries, so that you can compare urban forest effects between each stratum. 

 

Why It’s Important: The size entered in the “Area” column is used to calculate the per 

unit area, or density, estimates that are included in some of the Eco results on the 

Reports tab. The more accurate the area entered here, the better your density 

estimates will be. You can use the tools in the Actions group to add or delete strata. 

This is also simply a good place to reference the strata for your project! If you are doing 

a plot-based sample project, the strata that you define here will be visible in the User 

Defined function. The strata that you define here are also available in the mobile data 

collector if you collect your field data using a mobile device, as well as in the Data tab of 

the ribbon. 

 

Export 

 

CSV 

Description: This function allows you to export tabular data from an open function to a 

“comma separated values” (csv) file format. 

 

Why It’s Important: Data exported as a csv file are compatible with Microsoft Excel and 

text editors such as WordPad and Notepad. This function allows you to save and 

organize your project data however you choose. 

 

Actions 

 

The Actions group is available in the ribbon bar when you are working in a function that 

requires the following tools: 

 

New 

Description: This tool allows you to add a new class or category of data to the table that 

is open in the action panel. 

 

Undo 

Description: This tool allows you to undo the last action that you took. 

 

Redo 

Description: This tool allows you to redo an action that you had just negated using the 

Undo tool. 
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Restore Defaults 

Description: This tool will restore any default classes or categories of data to the table 

that is open in the action panel. 

 

Delete 

Description: This tool allows you to delete a selected class or category of data from the 

table that is open in the action panel. 

 

Editing Mode 

 

Editing Mode 

Description: This tool allows you to work in Editing mode so that you may edit or add to 

the project settings in the Project Configuration tab. 

 

Why It’s Important: After you run the Eco model in the Reports tab, the Project 

Configuration tab will be locked so it cannot be edited unintentionally. However, the 

project settings that you enter in the Project Configuration tab may be edited with 

caution. In order to do this, you will need to switch to Editing mode by clicking on the 

Editing Mode function. If you choose to work in Editing mode, you will need to submit 

your data to the server again and retrieve your updated results. 

 

Data 

 

On this tab, you can add, edit, or view your inventory data (i.e., the plot and/or tree data that you 

collect in the field). 

 

Data Collection 

 

Paper Form 

Description: This function displays the paper data collection forms provided by Eco. 

 

Why It’s Important: If you have decided to collect and record your field data on paper 

forms, this is where you will find Eco’s ready-made forms so you can save and print 

them. 

 

Submit to Mobile 

Description: This function submits your project configuration settings to the mobile data 

collector. If you are not planning to record your data in the field using the mobile data 

collector, then you do not need to use this tool. 

 

Why It’s Important: Your project configuration is unique to your project. Submitting your 

project settings using this tool ensures that your mobile data collector has the correct 

classes or categories when you go into the field to collect your data. If you do not first 
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submit your project configuration using this tool, you will not be able to access the 

mobile data collector. 

 

Retrieve from Mobile 

Description: This function imports your inventory data from the mobile data collector into 

Eco. If you did not record your data in the field using the mobile data collector, then you 

will not need to use this tool. 

 

Why It’s Important: If you recorded your data in the field using the mobile data collector, 

this is how you will import your data. This tool offers an easy way of bringing your 

inventory data into the application. 

 

Import 

Description: This tool allows you to import an existing tree inventory. 

 

Why It’s Important: Though this tool is only available for complete inventory projects, it 

allows those users with existing tree data to import it into Eco and make use of the 

model. 

 

Inventory Data 

 

Plots 

Description: Field data collected for each plot are entered in this function. You can also 

edit the plot data using the tools in the Actions group of the ribbon once it has been 

entered or imported here. 

 

Why It’s Important: If you are doing a plot-based sample project, this is where you can 

manually enter or edit your plot data. If you have already entered or imported your data, 

this function can simply be a place for viewing that data. 

 

Trees 

Description: Field data collected for each tree are entered in this function. You can also 

edit the tree data using the tools in the Actions group of the ribbon once it has been 

entered or imported here. 

 

Why It’s Important: For all projects, this is where you can manually enter or edit your tree 

data. If you have already entered or imported your data, this function can simply be a 

place for viewing that data. 

 

Shrubs 

Description: Field data collected for shrubs are entered in this function. You can also edit 

the shrub data using the tools in the Actions group of the ribbon once it has been 

entered or imported here. 
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Why It’s Important: If you are doing a plot-based sample project and collected shrub 

data, this is where you can manually enter or edit that data. If you have already entered 

or imported your data, this function can simply be a place for viewing that data. 

 

Check Data 

Description: The field data that you have imported or manually entered in the Plots, 

Trees, and/or Shrubs functions can be validated using the Check Data function. When 

you click on the Check Data function, Eco will check for invalid data and report issues 

that need to be corrected before you can submit your data to the server and retrieve 

your results.  

 

Export 

 

CSV 

Description: This function allows you to export tabular data from an open function to a 

“comma separated values” (csv) file format. 

 

Why It’s Important: Data exported as a csv file are compatible with Microsoft Excel and 

text editors such as WordPad and Notepad. This function allows you to save and 

organize your project data however you choose. 

 

KML 

Description: This function allows you to export tabular data from an open function to a 

“keyhole markup language” (kml) file format. 

 

Why It’s Important: If you have recorded the map coordinates of plot centers and/or 

trees, you will be able to make use of Eco’s KML function. Data exported as a kml file 

are compatible with software programs that include Google Earth and ArcGIS. This 

function allows you to view plot and tree data locations spatially. 

 

Inventory Value 

 

Benefit Prices 

Description: In this function, you can view or customize the benefit prices that will be 

used by the Eco model to estimate the economic value associated with the 

environmental benefits, such as carbon storage, provided by your urban forest. 

 

Why It’s Important: This is a great way to localize your results! Many of the default 

benefit prices available for Eco come from the scientific literature. This function allows 

you to enter data that is more relevant to your study area. Benefit prices may be edited 

at any time without requiring you to submit your project to the server again. The change 

to your monetary values will be reflected in the Reports tab immediately.  
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Annual Costs 

Description: In this function, you can include the annual costs associated with your 

project. There are no default costs for this function because they can vary significantly 

from place to place. The values that you provide here are primarily the annual costs 

associated with the management of your urban forest, such as tree planting or removal. 

However, there may be less obvious tree-related costs to consider, such as sidewalk 

repair costs or litigation fees. 

 

Why It’s Important: Providing annual cost information makes it possible to calculate a 

benefit-cost ratio which can be a valuable public-policy tool. Annual costs may be edited 

at any time without requiring you to submit your project to the server again. The change 

to your annual costs will be reflected in the Reports tab immediately. 

 

Actions 

 

The Actions group is available in the ribbon bar when you are working in a function that 

requires the following tools: 

 

New 

Description: This tool allows you to add a new class or category of data to the table that 

is open in the action panel. 

 

Undo 

Description: This tool allows you to undo the last action that you took. 

 

Redo 

Description: This tool allows you to redo an action that you had just negated using the 

Undo tool. 

 

Delete 

Description: This tool allows you to delete a selected class or category of data from the 

table that is open in the action panel. 

 

 

 

 

International Users: Remember the valuation data you collected in Phase 

II: Setting Up Your Project? The Benefit Prices function is where you 

will input your local values for estimating the economic value associated 

with certain tree benefits. Don’t forget – if you are choosing to use Eco’s 

default values, supply an exchange rate so your results will be given in 

your local currency.  

Tip 
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Editing Mode 

 

Editing Mode 

Description: This tool allows you to work in Editing mode so that you may edit or add to 

the inventory data in the Data tab. 

 

Why It’s Important: After you run the Eco model in the Reports tab, the Data tab, with 

the exception of the Benefit Prices and Annual Costs functions, will be locked so it 

cannot be edited unintentionally. The data that you enter in the Data tab may still be 

edited with caution. In order to do this, you will need to switch to Editing mode by clicking 

on the Enable Mode function. If you choose to work in Editing mode, you will need to 

submit your data to the server again and retrieve your updated results. 

 

View 

 

On this tab, you can specify how you would like to view your project data, including which 

dataset you would like to view and the style of the user interface. 

 

Specify Data 

 

Specify Data 

Description: This function offers three drop-down menus for you to specify which dataset 

you would like to view in the application. 

 

Why It’s Important: i-Tree Eco projects are stored in databases that may contain multiple 

datasets. Use this function to specify the project, series, and year of the dataset that you 

want to view in Eco. 

 

Species 

 

Species Codes 

Description: This function is a lookup tool that identifies the common name, scientific 

name, and species code associated with a tree species when you supply any one of the 

three descriptors. For example, if you know that the common name of one of your tree 

species is Red Maple, then supplying that name in the lookup tool will provide you with 

the corresponding species code and scientific name. 

 

Why It’s Important: i-Tree Eco features data for over 7,000 tree and shrub species, each 

of which is associated with a particular common name, scientific name, and species 

code. This lookup tool enables you to find those descriptors easily. 
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 Species Lists 

Description: This function includes a table that identifies the species code, scientific 

name, and common name of all of the tree species that are available in Eco. This list can 

be exported to a “comma separated values” (csv) file for use outside of Eco. 

 

Export 

 

CSV 

Description: This function allows you to export tabular data from an open function to a 

“comma separated values” (csv) file format. 

 

Why It’s Important: Data exported as a csv file are compatible with Microsoft Excel and 

text editors such as WordPad and Notepad. This function allows you to save and 

organize your project data however you choose. 

 

 

Configuration 

 

Style 

Description: The user interface of the Eco application can be customized by choosing 

one of the different color schemes from the drop-down list.  

 

Always Minimize Help Panel 

Description: Help text is available in the panel on the left-hand side of the i-Tree Eco 

window. This function allows you to have that help panel minimized at all times. You can 

also choose to maximize the help panel again by deselecting this option. 

 

Reports 

 

On this tab, you can run the i-Tree Eco model and view your results. Eco features a number of 

charts, tables, and reports to summarize the structure, function, and ecosystem services 

provided by the urban forest in your study area. 

 

 

 

 

 

 

Go to Phase V: Viewing Your Reports to explore all of the reports that are 

available for your custom Eco project in more detail. 

Tip 
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Project Metadata 

 

Project Metadata 

Description: This report summarizes important metadata for your project, including the 

date your project was created, number of plots and/or trees, pollution and weather data 

used, benefit prices, and available reports. 

 

Why It’s Important: The Project Metadata report is a good place to check if and when 

you ran the model and view some of the key information about your project.  

 

Submit Data for Processing 

 

Submit Data for Processing 

Description: This function begins data processing. When you click on this button, your 

project settings and inventory data will be sent to the i-Tree server where the Eco model 

will run. 

 

Why It’s Important: After you have established your project settings in the Project 

Configuration tab and entered your field data in the Data tab, it is time to run the i-Tree 

Eco model. 

 

Track & Retrieve Results 

 

Track & Retrieve Results 

Description: This function is essential after data processing. When you click on this 

button, you can retrieve your results from the i-Tree server and view your Eco reports. 

 

Why It’s Important: After the i-Tree Eco model has run on the server you can retrieve the 

results for your project – the big payoff for all your efforts! This function also allows you 

to track the status of your data submission and see where you are in the processing 

queue. 

 

 

 

 

 

 

 

 

If you make changes in the Project Configuration or Data tabs, you will need 

to send your data to the server again and retrieve your results so that the 

provided reports will be populated. 

Caution 

 
! 



48 
 

Formatted Reports 

 

Written Report 

Description: This is a summary, narrative report of your project results. This report gives 

a great overview of the trees in your study area, while describing urban forest benefits 

and the basic methodology used in i-Tree Eco. 

 

Composition and Structure 

Description: The standard reports in this drop-down menu summarize information about 

the composition and structure of the trees in your study area, including DBH (diameter at 

breast height), condition, and leaf area and biomass. These reports are in tabular or 

chart format and can be saved or printed for use outside of the Eco application. 

 

Benefits and Costs 

Description: The standard reports in this drop-down menu summarize information about 

the benefits and costs of the trees in your study area, including carbon storage and 

sequestration, energy effects, and pollution removal. These reports are in tabular or 

chart format and can be saved or printed for use outside of the Eco application. 

 

Measured Tree Details 

Description: The standard reports in this drop-down menu summarize information about 

the individual trees sampled in your study area. Reports include data about the 

composition and structure of the sampled trees, as well as benefits and costs. These 

reports are in tabular or chart format and can be saved or printed for use outside of the 

Eco application. 

 

Air Quality Health Impacts and Values 

Description: This is a standard report that provides estimates of the number of adverse 

health incidents avoided due to changes in pollutant concentration levels, as well as the 

economic value of reduced health incidents. This report is in tabular format and can be 

saved or printed for use outside of the Eco application. 

 

Pest Analysis 

Description: The standard reports in this drop-down menu summarize information about 

the pest susceptibility of trees in your urban forest, as well as signs and symptoms of 

 

 

If you are doing a plot-based sample project, remember that the reports in the 

Measured Tree Details drop-down menu are only reporting results for the 

trees that you sampled during field data collection. These results do not 

represent the entire population in your study area. 

Caution 

 
! 
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pests in your study area. These reports are in tabular or chart format and can be saved 

or printed for use outside of the Eco application. 

 

Charts 

 

Pollution and Weather 

Description: The standard reports in this drop-down menu summarize information about 

the pollution and weather data used for your project, including air pollutant 

concentration, rain, temperature, air quality improvement, and transpiration. These 

reports are in tabular or chart format and can be saved or printed for use outside of the 

Eco application. 

 

Model Notes 

 

Model Notes 

Description: The notes available here provide more information about the data 

processing that occurs within the Eco model. For example, notes displayed here may tell 

a user that because energy data collected for a specific tree was invalid, it has not been 

included in estimated energy effects. 

 

Why It’s Important: This function provides a good opportunity to see if any errors have 

occurred during data collection or data entry. You can use the key below your 

processing notes to decipher any errors that occurred and determine how to resolve 

them. 

 

Units 

 

English or Metric 

Description: Choose to view your results in English (e.g., inches) or metric (e.g., 

centimeters) units. 

 

Why It’s Important: This function converts your results to English or metric units so you 

can view them in a way that suits your needs. This is also helpful if you have chosen to 

record your field data using one set of units, but would like to see results reported in 

different units. 

 

 

 

Reports summarizing documented signs and symptoms of tree pests and 

diseases require additional pest data to be collected. Please refer back to 

Phase III: Collecting Your Field Data for more information on the 

requirements for the supplemental pest analysis. 

Tip 
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Species Names 

 

Common or Scientific 

Description: Choose to view your species by scientific name (e.g., Acer rubrum) or 

common name (e.g., Red maple). 

 

Why It’s Important: Many of the model outputs are reported by species. This function 

converts your results to scientific or common name so you can view them in a way that 

suits your needs. 

 

Forecast 

 

On this tab, you can run Eco’s Forecast component at a basic or advanced level and view the 

results of that run. To estimate what your urban forest will look like in the future, Forecast uses 

the structural estimates (e.g., number of trees, species composition) generated by running the i-

Tree Eco model along with anticipated growth and mortality rates. You can even include future 

tree planting scenarios or possible adverse events, such as a storm or pest infestation, to 

predict their impact on your urban forest. 

 

Configuration Summary 

 

Configuration Summary 

Description: This is a summary report that displays all of the parameters that you defined 

for the active configuration. This includes parameters defined under the Basic Options 

function, such as number of years to forecast, frost-free days, and base annual mortality 

rates, as well as any additional annual mortality rates or tree planting and extreme event 

scenarios that you defined. If you have chosen to run Forecast using the defaults 

provided, you will see those values here as well. 

 

 

 

Look at the Eco Guide to Using the Forecast Model for detailed 

directions. 

Eco Guide  

 

 

Don’t be shy – try just clicking the Run Forecast button in the ribbon bar! 

The Forecast model will use the provided default values and give you a 

basic estimate of what your urban forest will look like in the future. You can 

choose to make changes to the defaults later if you like. 

 

Tip 

https://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_UsingForecast.pdf
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Run Forecast 

 

Run Forecast 

Description: This function is used to begin running the Forecast model. 

 

Why It’s Important: Clicking on the Run Forecast button starts the process of estimating 

your future urban forest. The configuration selected in the Active Configuration drop-

down menu on the ribbon defines the settings for your Forecast results. Make sure that 

the desired configuration is selected before running Forecast. 

 

Basic Options 

 

Basic Options 

Description: In this function, you can set the number of years into the future your results 

will be forecasted, the number of days without frost in your study area, and basic annual 

mortality rates.   

 

Why It’s Important: The variables that you can set in this function allow you to customize 

your Forecast results at a very basic level. Please note that making changes here is 

optional. You can always run the model using the defaults provided! 

 

Custom Options 

 

Annual Mortality Rates 

Description: In this function, you can define your annual mortality rates. 

 

Why It’s Important: The rates that you set in this function allow you to customize your 

Forecast results at a more advanced level. One of the advantages of setting advanced 

mortality rates is that you can apply annual mortality rates to specific condition classes, 

strata, or genera. Please note that making changes here is optional. You can always run 

the model using the defaults provided! 

 

Trees to Plant 

Description: In this function, you can define one or more tree planting scenarios. 

 

Why It’s Important: The tree planting scenarios that you define in this function allow you 

to customize your Forecast results at a more advanced level. One of the advantages of 

including tree planting scenarios is that you can model what your urban forest will look 

like in the future as a result of one or more tree planting events, allowing you to account 

for tree planting in your study area (or even natural regeneration, which can be factored 

in as if it were tree planting). Please note that adding scenarios here is optional. You do 

not need planting scenarios to run the model! 
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Extreme Events 

 

 Pest Outbreaks 

Description: In this function, you can define one or more pest outbreaks, such as an 

emerald ash borer infestation, and the annual mortality rate associated with each 

event. 

 

 Weather Events 

Description: In this function, you can define one or more weather events, such as 

hurricane or tropical storm, and the annual mortality rate associated with each event. 

 

Why It’s Important: The extreme events that you define in this function allow you to 

customize your Forecast results at a more advanced level. One of the advantages of 

defining extreme events is that you can model what your urban forest will look like in the 

future as a result of the loss of trees. Extreme events can be set as a single incident or 

recurring event. Please note that adding events here is optional. You do not need 

extreme events to run the model! 

 

Configurations 

 

The Configurations group of the Forecast tab encompasses multiple functions, including the 

Active Configuration drop-down list and Rename, New, Duplicate, Delete, and Restore 

Defaults functions. One of the useful features of Forecast is that you can make use of the 

component many different ways by projecting future estimates with any number of combinations 

of settings, tree planting scenarios, and extreme events. Each one of these combinations is a 

different configuration and can be defined by going through the Basic or Custom Options of 

the ribbon. You can also choose to run Forecast without providing any special information and 

simply using the defaults provided. 

 

Active Configuration 

Description: This drop-down menu includes all of the Forecast configurations that you 

have created for your Eco project. 

 

Why It’s Important: The settings associated with the “active” configuration displayed here 

are what will be used when you decide to run Forecast. 

 

 

You can choose to work with a different configuration at any time. Simply 

select the desired configuration from the Active Configuration drop-down 

menu! When you click on one of the other buttons or functions in the 

ribbon, the settings or reports will then be associated with that 

configuration.  

Tip 
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Rename 

Description: This tool allows you to rename the configuration that is displayed in the 

Active Configuration drop-down menu. 

 

New 

Description: This tool allows you to create a new Forecast configuration. Your new 

configuration will contain all of the default Forecast settings until you make changes. 

 

Duplicate 

Description: This tool allows you to duplicate the configuration that is displayed in the 

Active Configuration drop-down menu. 

 

Why It’s Important: This a useful tool if you have created a custom configuration. By 

duplicating your custom configuration, you can start with whatever changes you have 

already made to the settings and just make desired modifications to create different 

scenarios more easily. 

 

Delete 

Description: This tool allows you to delete the configuration that is displayed in the 

Active Configuration drop-down menu. 

 

Restore Defaults 

Description: This tool will restore the default Forecast settings to the configuration that is 

displayed in the Active Configuration drop-down menu. 

 

Reports 

 

Composition and Structure 

Description: The standard reports in this drop-down menu summarize information about 

the structure of your future urban forest, including number of trees, tree cover, DBH 

(diameter at breast height), and leaf area and biomass. These reports are in tabular or 

chart format and can be saved or printed for use outside of the Eco application. 

 

Benefits 

Description: The standard reports in this drop-down menu summarize information about 

the function of your future urban forest, including carbon storage and sequestration and 

pollution removal. These reports are in tabular or chart format and can be saved or 

printed for use outside of the Eco application. 

 

Units 

 

English or Metric 

Description: Choose to view your results in English (e.g., inches) or metric (e.g., 

centimeters) units. 
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Why It’s Important: This function converts your Forecast results to English or metric units 

so you can view them in a way that suits your needs. This is also helpful if you have 

chosen to record your field data using one set of units, but would like to see results 

reported in different units. 

 

Editing Mode 

 

Editing Mode 

Description: This tool allows you to work in Editing mode in the Forecast tab. 

 

Why It’s Important: After the Forecast model has been run using a specified 

configuration, the settings of that configuration will be locked so they cannot be edited 

unintentionally. In order to edit those settings, first make sure that the appropriate 

configuration is selected in the Active Configuration drop-down menu and then switch 

to Editing mode by clicking on the Editing Mode function. If you choose to work in 

Editing mode, you will need to run Forecast again using that configuration to get updated 

results. 

 

Support 

 

On this tab, you can access i-Tree Eco’s numerous support resources. 

 

User Manual 

Description: This function provides detailed specifications on setting up a project and 

carrying out data collection in the field. 

 

User Guides 

Description: This function provides topic-specific information to help users work through 

specific tasks for their project. The user guides available here are the same that are 

referenced throughout this manual. 

 

Video Learning 

Description: This function links you to the webpage where you can access instructional 

videos and archived webinars to learn more about the i-Tree Eco application. 

 

User Forum 

Description: This function links you to the webpage where you can participate in a 

moderated discussion forum to solicit advice, get technical questions answered, 

communicate experiences, and view frequently asked questions (FAQs). 
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i-Tree Website 

Description: This function links you to the webpage where you can learn about all of the 

i-Tree applications and utilities, access i-Tree support resources, and read about what’s 

new with i-Tree. 

 

Report a Bug 

Description: This function links you to the webpage where you can report technical 

issues that affect the operational functionality of the i-Tree Tools. 

 

Software Update 

Description: This function checks for new versions of the i-Tree Eco software and 

downloads software updates. 

 

About 

Description: This option provides general information for the i-Tree Eco application. You 

can read an overview of the i-Tree Eco model and view version information, 

acknowledgements, and credits. 

 

License Agreement 

Description: This function opens the i-Tree End User’s License Agreement that you 

agree to when you download the i-Tree software and run an Eco project. 

 

Feedback 

Description: This function links you to the webpage where you can provide feedback 

about your experience using the i-Tree Eco application. 

 

What’s New 

Description: This option provides you with a list of new features in Eco v6.0. You can 

read an overview of significant upgrades over previous versions and other important 

differences. 

 

 

To add or edit your project data in Eco, click on your computer’s Start button > (All) Programs 

> i-Tree > i-Tree Eco v6. You should have already created a new project before going out in 

the field to collect data. However, if you have not, refer back to Phase III > Preparing for the 

Field for directions on Getting Started in Eco or follow Eco’s on-screen help text. 

 

 Adding Data 

 

 

The Data tab is where you add your new data manually or edit data that has 

already been entered.  

Tip 
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To open an existing project: 

1 Click File > Open Project. 

2 Browse to the folder where you saved your project, click on the file name, and click 

Open. 

 

From Paper Forms 

 

If you recorded your data using Eco’s paper form, you will have to enter your data manually: 

 

1 Click on the Data tab. 

2 Use the functions in the Inventory Data group of the ribbon.  

 

The data entry forms are in table format and allow you to enter or edit data for plots, trees, and 

shrubs, depending on how you customized your project. The tools in the Action group allow you 

to add new records, delete existing records, and undo or redo the last actions that you took. 

 

From the Mobile Data Collector 

 

If you recorded your data using Eco’s mobile data collector, you can import your data directly 

into Eco: 

 
1 Click on the Data tab. 

2 Click on the Retrieve from Mobile function. 

3 Enter your password in the space provided. 

4 Click Show List and a description of your data will appear. 

5 Check the box next to the record(s) that you would like to retrieve. Each record includes 

a description and date to help you determine which records should be imported. 

6 Click Retrieve Data. 

 

From the Complete Inventory Importer 

 

If you have an existing tree inventory, you can import your data directly into your complete 

inventory project: 

 

1 Click on the Data tab. 

 

2 Click on the Trees function. (Note: The Import tool will become available in the ribbon.) 

 

3 Click on the Import tool to import your existing tree inventory. 

 

4 In the Data Import Wizard, click Browse. 
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a Navigate to the file containing your inventory data.  

 

b Select the file and click Open. 

 

5 Confirm that the data that appears in the table is correct and click Next. 

 

6 Match your existing data fields to Eco’s data fields. 

 

a Select an inventory column from the table. The column header will appear in the 

“Your Source Column” space towards the bottom of the window. 

 

b Choose the “Eco Field” from the drop-down list that defines the type of data in 

your selected column. 

 

c Check the box indicating whether or not you will need to map your field values to 

the Eco field values. (Note: You will be prompted to complete the value mapping 

later. See step 8.) 

 

d CONDITIONALLY REQUIRED: As previously described, Eco data variables can 

often be displayed in several ways. For example, species data can be entered as 

common name, scientific name, or species code. For data variables where this 

applies, a “Field Type” drop-down list will appear below “Eco Field.” Select the 

field type that matches your existing data. 

 

e Repeat steps 6a through 6d until each variable that you would like imported has 

been matched to the appropriate Eco field. 

 

7 Click Next. 

 

8 CONDITIONALLY REQUIRED: For data variables that you indicated the need to map 

field values (step 6c), match your field values to Eco’s. 

 

a In the upper table, select a row. 

 

b In the lower table, choose the “Eco Value” from the drop-down list that matches 

“Your Value.”  

 

 

 

Try moving from left to right clicking on each column in turn. This can help 

ensure that you match all of the necessary columns to an Eco field. 

Tip 
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c Move through the lower table until all of your values have been matched to an 

Eco value. 

 

d Repeat steps 8a through 8c until all necessary data variables have been 

mapped. 

 

9 Click Next. 

 

10 Review the results of your processed data at the top of the Data Import Wizard. This 

information will tell you how many records from your inventory data will be imported. 

 

11 When you are satisfied with the data that will be imported, click Finish. (Note: Use the 

Back button to return to previous steps to make adjustments.) 

  

 

 

For more information on importing a complete inventory, please see the Eco 

Guide to Importing an Existing Inventory. 

Eco Guide  

http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InventoryImporter.pdf
http://www.itreetools.org/resources/manuals/Ecov6_ManualsGuides/Ecov6Guide_InventoryImporter.pdf
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After you have established your project settings in the Project Configuration tab and entered 

your field data in the Data tab, it is time to run the i-Tree Eco model and get the results for your 

project! 

 

i-Tree Eco presents model results in the Reports tab that include charts, tables, and a 

summary, narrative report. Functions that are greyed out cannot be accessed at that point. If 

you have not yet run the i-Tree Eco model, most of the reports, charts, and tables will not be 

available until after you have done so. Depending on the type of project and data collected, 

some analyses may not be completed.  

 

 

To start, open your existing project: 

1 Click File > Open Project. 

2 Browse to the folder where you saved your project, click on the file name, and click 

Open. 

 

Running the Eco model is a two-step process that is necessary to view your reports or use 

Forecast. The first step is to send your data to the i-Tree server where the Eco model will be 

run. The second step is to retrieve your results from the server. 

 

First, send your data to the i-Tree server: 

 

1 Click on the Reports tab. 

2 Click on the Submit Data for Processing function. 

3 Read the i-Tree End User’s License Agreement and click OK if you consent. 

4 In the Contact Information window, enter your personal information in the spaces 

provided.  

5 To confirm your email address, enter the same email address in the spaces labeled 

“Email” and “Confirm.” This information is critical. 

6 Click OK. 

 

Please be patient – model processing time depends on the number of projects that have been 

recently submitted to the server as well as the size of your project. You can click on the Track & 

Retrieve Results function to track your status in the queue. 

 

When your data have been processed, an auto-generated email notifying you that the results 

are ready to download will be sent to the email address that you provide in the Contact 

Information window. This email will be from info@itreetools.org; please check your spam 

Phase V: Viewing Your Reports 

 Running the Eco Model 

mailto:info@itreetools.org
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folders if you do not receive the email. Likewise, you will be notified of processing errors that 

require data to be submitted again. If you do not receive your results within 24 hours, please 

contact info@itreetools.org. 

 

Second, retrieve your results from the i-Tree server: 

 

1 Click on the Reports tab. 

2 Click on the Track & Retrieve Results function. 

3 In the Retrieve Processed Results window, click OK. 

4 Please be patient while results are downloaded. 

 

You will see that many of the reporting options listed in the ribbon bar are greyed out and 

unavailable until after you load your results from the server. 

 

If you are unsure whether or not you have run the Eco model, you can check the Project 

Metadata report of the Reports tab. This information is especially useful since you may find it 

necessary to run the i-Tree Eco model more than once throughout the duration of your project. 

 

 

Read through the descriptions in this section of the manual to learn more about the reports 

provided in Eco. The reports that are available to you are entirely based on the nature of your 

project and the data that you collected in the field or provided during project configuration. The 

Project Metadata report in the Reports tab provides a list of all possible Eco reports and 

indicates which ones are available for your specific project. 

 

 

i-Tree Eco provides a wide variety of standard reports to users.  

 

 

 Overview of Reports 

 

 

Need help interpreting some of your results? The Glossary of this manual 

is a great resource for definitions of key terms!  

Tip 

 

 

If you make changes to your project settings or add or edit your field data, you 

will need to send your data to the server and retrieve your results again to 

ensure that your changes are reflected in your reports. 

Caution 

 
! 

mailto:info@itreetools.org
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The Formatted Reports group contains four drop-down lists to choose reports from: 

 Composition and Structure charts and tables present information on the structural 

aspects of the urban forest of your study area, including population size, species 

composition, leaf area, tree condition, and biomass information. Results are provided in 

a variety of ways, such as classified by DBH size class or by strata or presented on a 

per-unit-area (per-acre or per-hectare) basis. 

 

 Benefits and Costs charts and tables present information on the environmental benefits 

that are provided by the urban forest in your study area. Results are provided in 

functional units (e.g., tons of carbon sequestered) and in associated monetary values.  

 

 Measured Tree Details charts and tables present information on the characteristics of 

the sampled trees in your study area, including structural aspects and ecosystem 

services. Results are provided for each individual tree, as well as by species.  

 

 Pest Analysis charts and tables include a standard report for all users on the 

susceptibility of their urban forest to known pests. For users who choose to conduct the 

Pest Detection Module, additional reports summarize the results of that analysis. 

 

The Charts group contains one drop-down list to choose reports from: 

 Pollution and Weather charts and tables present information from the weather and 

pollution data used for your project, including rain, temperature, air pollutant 

concentration, air quality improvement, and transpiration. 

 

The Model Notes function provides more information about the data processing that occurs 

within the Eco model. 

 

The Units and Species Names groups include functions that allow you to set how units (i.e., 

English or metric) and species names (i.e., common or scientific) are displayed in your reports. 

You may choose to switch between the available options while you view your reports. 

 

 

 Reports 

 

 

If you are doing a plot-based sample project, remember that the reports in the 

Measured Tree Details drop-down menu are only reporting results for the 

trees that you sampled during field data collection. These results do not 

represent the entire population in your study area. 

Caution 

 
! 
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Project Metadata 

 

This report provides important information describing your project, including: 

 Version of i-Tree Eco used 

 Date when the project was created 

 Whether or not the model has been run 

 Project name, series, and year 

 Description of project settings 

 Details about pollution and weather data used 

One important piece of information that can be gathered here is whether or not the i-Tree Eco 

model has been run. This information is especially useful since you may find it necessary to run 

the i-Tree Eco model more than once throughout the duration of your project. 

 

Written Report 

 

This report includes a summary and discussion of the following results from your project: 

 Tree characteristics of the urban forest 

 Urban forest cover and leaf area 

 Ecosystem services (air pollution removal, carbon storage, etc.) 

 Structural and functional values of trees 

 Potential pest impacts 

 i-Tree Eco methods 

 

Composition and Structure Reports 

 

Structure Summary > By Species 

This report provides a summary of Eco’s structural estimates, including number of trees, leaf 

area, leaf biomass, tree biomass, and average condition, for each species in your study area. 

 

Structure Summary > By Strata and Species 

This report provides a summary of Eco’s structural estimates, including number of trees, leaf 

area, leaf biomass, tree biomass, and average condition, for the tree species in each stratum in 

your study area. 

 

Population Summary > By Species 

This report provides total estimates and percent contributions of the number of trees for each 

species in your study area. Results are displayed in pie chart and table formats. 

 

Population Summary > By Strata 

This report provides total estimates and percent contributions of the number of trees found in 

each stratum in your study area. Results are displayed in bar chart, pie chart, and table formats. 
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Population Summary > By Strata per Unit Area 

This report provides per area (density) estimates of the number of trees found in each stratum in 

your study area. Per area estimates are calculated by dividing the total number of trees in each 

stratum by the area of the stratum. This report displays results in bar chart and table formats. 

 

Population Summary > Public and Private by Strata 

This report provides estimates of the number of trees and percent of trees that were designated 

as public or private trees. Public tree and private tree results are summarized in separate tables 

by strata. The tables display the following information: 

 Number of Trees – number of trees in stratum that were classified as public or private. 

 % of Strata Trees – percent of trees in stratum that were classified as public or private. 

For example, in the “Summary of Public Trees” table, 100% would indicate that all trees 

located in that stratum were classified as public. 

 % of Public Trees – percent of all trees classified as public that were located in each 

stratum. For example, 50% would indicate that half of all public trees were located in that 

stratum. 

 % of Private Trees – percent of all trees classified as private that were located in each 

stratum. For example, 25% would indicate that one quarter of all private trees were 

located in that stratum. 

 % of All Trees – percent of the total number of trees that were classified as public or 

private and located in each stratum. For example, in the “Summary of Public Trees” 

table, 0% would indicate that none of the total number of trees were classified as public 

and located in that stratum. 

 

Population Summary > Street Trees by Strata 

This report provides estimates of the number of trees and percent of trees that were designated 

as street trees or non-street trees. Street tree and non-street tree results are summarized in 

separate tables by strata. The tables display the following information: 

 Number of Trees – number of trees in stratum that were classified as street trees or non-

street trees. 

 % of Strata Trees – percent of trees in stratum that were classified as street trees or 

non-street trees. For example, in the “Summary of Street Trees” table, 100% would 

indicate that all trees located in that stratum were classified as street trees. 

 % of Street Trees – percent of all trees classified as street trees that were located in 

each stratum. For example, 50% would indicate that half of all street trees were located 

in that stratum.   

 % of Non-Street Trees – percent of all trees classified as non-street trees that were 

located in each stratum. For example, 25% would indicate that one quarter of all non-

street trees were located in that stratum.  

 % of All Trees – percent of the total number of trees that were classified as street trees 

or non-street trees and located in each stratum. For example, in the “Summary of Street 

Trees” table, 0% would indicate that none of the total number of trees were classified as 

street trees and located in that stratum. 
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Species Distribution > By DBH Class (chart) 

This report provides estimates of the proportion of trees of each species that falls into each 

diameter at breast height (DBH) size class. Results are displayed in chart format for the 10 most 

common species, showing the percent of the tree species population by DBH class. 

 

Species Distribution > By DBH Class (vertical table) 

This table provides estimates of the proportion of trees of each species that falls into each 

diameter at breast height (DBH) size class. Results are displayed for the percent of the tree 

species population by DBH class and include estimates of standard error. If all DBH classes 

cannot fit across the top of the table, the vertical display breaks the results into several tables so 

you can scroll down through all species in your study area before reaching the remaining DBH 

classes. 

 

Species Distribution > By DBH Class (horizontal table) 

This table provides estimates of the proportion of trees of each tree species that falls into each 

diameter at breast height (DBH) size class. Results are displayed for the percent of the tree 

species population by DBH class and include estimates of standard error. If all DBH classes 

cannot fit across the top of the table, the horizontal display breaks the results into several tables 

so you can scroll to the right through all DBH classes. 

 

Species Distribution > By DBH Class and Strata (vertical table) 

This table provides estimates of the proportion of trees of each tree species by strata that falls 

into each diameter at breast height (DBH) size class. Results are displayed for the percent of 

the tree species population by DBH class and include estimates of standard error. If all DBH 

classes cannot fit across the top of the table, the vertical display breaks the results into several 

tables so you can scroll down through all species in your study area before reaching the 

remaining DBH classes. 

 

Species Distribution > By DBH Class and Strata (horizontal table) 

This table provides estimates of the proportion of trees of each tree species by strata that falls 

into each diameter at breast height (DBH) size class. Results are displayed for the percent of 

the tree species population by DBH class and include estimates of standard error. If all DBH 

classes cannot fit across the top of the table, the horizontal display breaks the results into 

several tables so you can scroll to the right through all DBH classes. 

 

Importance Value > By Species 

This table provides estimates of the percent population, percent leaf area, and importance value 

for each tree species in your study area. Results are ordered from the highest to lowest 

importance value. Importance value (IV) is calculated as the sum of the percent population and 

percent leaf area. High importance values do not mean that these trees should necessarily be 

encouraged in the future; rather, these species currently dominate the urban forest structure. 

 

Diversity Indices > By Strata 

This table provides estimates of various diversity indices by strata in your study area. The 
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diversity indices presented here serve as indicators of species richness, dominance, and 

evenness. This table displays the following information by strata: 

 Richness – number of species sampled. 

 Per area estimates of number of species – density estimates calculated by dividing the 

total number of species in each stratum by the area of the stratum. 

 Shannon-Wiener diversity index – a diversity index that serves as an indicator for 

species richness. Because this index assumes that all species within a stratum or study 

area have been sampled, it has a moderate sensitivity to sample size; therefore, strata 

and/or cities may not be comparable.  

 Menhinick’s diversity index – another diversity index that also serves as an indicator for 

species richness. This index has a low sensitivity to sample size and therefore may be 

more appropriate for comparison between strata. 

 Simpson’s diversity index – a diversity index that serves as an indicator for species 

dominance. It also has a low sensitivity to sample size and therefore may be more 

appropriate for comparison between strata. 

 Shannon-Wiener evenness index – an evenness index that, like the Shannon-Wiener 

diversity index, assumes that all species within a stratum or study area have been 

sampled. Similarly, it has a moderate sensitivity to sample size; therefore, strata and/or 

cities may not be comparable. 

 Sander’s rarefaction technique – a technique used for assessing species richness of 

samples. For a particular stratum, this value is the number of species one would expect 

to find if four trees were sampled in the stratum. For the city, this value is the number of 

species one would expect to find if 250 trees were sampled within the city. 

 

Species Range > Native Status by Strata 

This table provides estimates of the percent of the trees in each stratum that are native to the 

state that the study area is located in. Possible places of origin include: 

 State (for U.S. projects only) 

 Africa 

 Africa & Asia 

 Asia 

 Asia & Australia 

 Asia & Australia + 

 Australia 

 Europe 

 Europe & Africa 

 Europe & Asia 

 Europe & Asia + 

 North America 

 North America + 

 North & South America 

 North & South America + 

 Other 
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 South America 

 Unknown 

”Unknown” indicates that the origin of the tree species is unknown; places of origin that include 

two continents indicate that the tree species is native to both continents; and places of origin 

marked with a “+” indicate that the tree species is native to the place of origin listed plus another 

continent that is not listed. For projects in the U.S., “State” is an additional place of origin that is 

reported and refers to the state in which the study area is located. 

 

Condition > By Species 

This table provides estimates of the percent of each tree species found in each condition class. 

The following condition classes are included in the table: 

 Excellent 

 Good 

 Fair 

 Poor 

 Critical 

 Dying 

 Dead 

For users providing custom classes, refer back to the Condition or Dieback function of the 

Project Configuration tab to see how the default classes displayed here are defined in terms 

of your custom classes. Please be aware that using custom classes makes comparing results 

across projects more difficult and should be done with caution. 

 

Condition > By Strata and Species 

This table provides estimates of the percent of each tree species by strata found in each 

condition class. The following condition classes are included in the table: 

 Excellent 

 Good 

 Fair 

 Poor 

 Critical 

 Dying 

 Dead 

For users providing custom classes, refer back to the Condition or Dieback function of the 

Project Configuration tab to see how the default classes displayed here are defined in terms 

of your custom classes. Please be aware that using custom classes makes comparing results 

across projects more difficult and should be done with caution. 

 

Leaf Area > By Strata 

This report provides total estimates and percent contributions of the leaf area found in each 

stratum in your study area. Results are displayed in bar chart, pie chart, and table formats. 
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Lear Area > By Strata per Unit Area 

This report provides per area (density) estimates of the leaf area found in each stratum in your 

study area. Per area estimates are calculated by dividing the total leaf area in each stratum by 

the area of the stratum. Results are displayed in bar chart and table formats. 

 

Leaf Area and Biomass > Of Shrubs by Strata 

This table provides per area (density) and total estimates of leaf area and leaf biomass for each 

shrub species by strata. Per area estimates are calculated by dividing the total leaf area or total 

leaf biomass in each stratum by the area of the stratum. Results include estimates of standard 

error. 

 

Leaf Area and Biomass > Of Trees and Shrubs by Strata 

This table provides per area (density) and total estimates of leaf area and leaf biomass for tree 

and shrub species by strata. Per area estimates are calculated by dividing the total leaf area or 

total leaf biomass in each stratum by the area of the stratum. Results include estimates of 

standard error. 

 

Ground Cover Composition > By Strata 

This table provides estimates of percent ground cover for each stratum in your study area. 

Results include estimates of standard error. The ground cover classes included here are 

defined in the Ground Cover function on the Project Configuration tab. 

 

Land Use Composition > By Strata 

This table provides estimates of the amount of each stratum in your study area classified 

according to the actual land uses measured in the field. If you have chosen to stratify your 

project by land use, this table provides a useful look at how closely aligned your strata 

classifications are with actual land uses. Strata are defined in the Project & Strata Area 

function of the Project Configuration tab. Land uses are defined in the Land Use function on 

the Project Configuration tab. 

 

Relative Performance Index > By Species 

This table provides estimates of relative performance index (RPI) by tree species. RPI 

compares the overall condition of each species to all the others. Values that are higher than 1 

indicate that a species has a proportionately better condition rating.  

 

Maintenance > Recommended 

This table provides estimates of the number of trees, percent of species, and percent of all trees 

that were designated as needing some kind of recommended maintenance. Results are 

presented by recommended maintenance type, species, and DBH size class. 

 

Maintenance > Task 

This table provides estimates of the number of trees, percent of species, and percent of all trees 

that were as assigned to receive a particular maintenance task. Results are presented by 

maintenance task, species, and DBH size class. 
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Maintenance > Sidewalk Conflicts 

This table provides estimates of the number of trees, percent of species, and percent of all trees 

that were designated as posing a sidewalk conflict. Results are presented by type of sidewalk 

conflict, species, and DBH size class. 

 

Maintenance > Utility Conflicts  

This table provides estimates of the number of trees, percent of species, and percent of all trees 

that were designated as a utility conflict class. Results are presented by type of utility conflict, 

species, and DBH size class. 

 

Other > Other One / Two / Three 

If you created one or more custom data fields (maximum of three) during project configuration, 

these tables will provide estimates of the number of trees, percent of species, and percent of all 

trees that were designated according to those custom fields. Results are presented by type of 

custom data, species, and DBH size class. 

 

Benefits and Costs Reports 

 

Benefits Summary > By Species 

This report provides a summary of Eco’s benefit estimates, including number of trees, carbon 

storage and sequestration, avoided runoff, pollution removal, and structural value, for each 

species in your study area. 

 

Benefits Summary > By Strata and Species 

This report provides a summary of Eco’s benefit estimates, including number of trees, carbon 

storage and sequestration, avoided runoff, pollution removal, and structural value, for the tree 

species in each stratum in your study area. 

 

Carbon Storage of Trees > By Species 

This report provides total estimates and percent contribution of carbon storage of trees by 

species in your study area. Results are also reported in carbon dioxide equivalent by multiplying 

carbon storage by the ratio of their atomic weights (44/12). Results are displayed in table 

format. 

 

 

Monetary values are based on the Benefit Prices function of the Data tab. 

To edit benefit prices, open that function and follow the steps outlined in 

the Help panel. This form can be edited at any time and you will not be 

required to submit your project again. Results on the Reports tab will 

reflect the change in benefit prices immediately. 

Tip 
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Carbon Storage of Trees > By Strata 

This report provides total estimates and percent contribution of carbon storage of trees by strata 

in your study area. Results are also reported in carbon dioxide equivalent by multiplying carbon 

storage by the ratio of their atomic weights (44/12). Results are displayed in bar chart, pie chart, 

and table formats. 

 

Carbon Storage of Trees > By Strata per Unit Area 

This report provides (density) per area estimates of carbon storage of trees by strata in your 

study area. Per area estimates are calculated by dividing the total carbon storage in each 

stratum by the area of the stratum. Per area estimates are also reported for the carbon dioxide 

equivalent. Results are displayed in bar chart and table formats. 

 

Annual Carbon Sequestration of Trees > By Species 

This report provides total estimates of gross carbon sequestration of trees by species in your 

study area. Results are also reported in carbon dioxide equivalent by multiplying carbon 

sequestration by the ratio of their atomic weights (44/12). Results are displayed in table format. 

 

Annual Carbon Sequestration of Trees > By Strata 

This report provides total estimates of gross carbon sequestration of trees by strata in your 

study area. Results are also reported in carbon dioxide equivalent by multiplying carbon 

sequestration by the ratio of their atomic weights (44/12). Results are displayed in bar chart and 

table formats. 

 

Annual Carbon Sequestration of Trees > By Strata per Unit Area 

This report provides per area (density) estimates of gross carbon sequestration of trees by 

strata in your study area. Per area estimates are calculated by dividing the total gross carbon 

sequestration in each stratum by the area of the stratum. Per area estimates are also reported 

for the carbon dioxide equivalent. Results are displayed in bar chart and table formats. 

 

Annual Net Carbon Sequestration of Trees > By Species 

This report provides total estimates of net carbon sequestration of trees by species in your study 

area. Net sequestration is a measure of the carbon sequestered by trees calculated as the 

gross carbon sequestered minus the carbon emissions due to decomposition after tree death. 

Results are also reported in carbon dioxide equivalent by multiplying carbon sequestration by 

the ratio of their atomic weights (44/12). Results are displayed in table format. 

 

Annual Net Carbon Sequestration of Trees > By Strata 

This report provides total estimates of net carbon sequestration of trees by strata in your study 

area. Net sequestration is a measure of the carbon sequestered by trees calculated as the 

gross carbon sequestered minus the carbon emissions due to decomposition after tree death. 

Results are also reported in carbon dioxide equivalent by multiplying carbon sequestration by 

the ratio of their atomic weights (44/12). Results are displayed in bar chart and table formats. 
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Annual Net Carbon Sequestration of Trees > By Strata per Unit Area 

This report provides per area (density) estimates of net carbon sequestration of trees by strata 

in your study area. Net sequestration is a measure of the carbon sequestered by trees 

calculated as the gross carbon sequestered minus the carbon emissions due to decomposition 

after tree death. Per area estimates are calculated by dividing the total gross carbon 

sequestration in each stratum by the area of the stratum. Per area estimates are also reported 

for the carbon dioxide equivalent. Results are displayed in bar chart and table formats. 

 

Energy Effects > Of Trees 

This table provides total estimates of the effect of trees in your study area on energy usage. 

Estimates are included for the following energy effects: 

 Effect on building energy use (i.e., increases or decreases in the number of MBTUs and 

MWHs used for heating or cooling residential buildings in study area) 

 Effect on carbon emissions (i.e., increases or decreases in carbon emissions from power 

sources as a result of changes in energy use) 

 Value of effects (i.e., economic values associated with the changes in building energy 

use and carbon emissions) 

 

Avoided Runoff of Trees > By Species 

This table provides total estimates of stormwater runoff avoided due to trees by species in your 

study area. This table includes estimates for the following: 

 Number of trees 

 Leaf area 

 Potential evapotranspiration 

 Evaporation 

 Transpiration 

 Water intercepted 

 Avoided runoff 

 Avoided runoff value 

 

Avoided Runoff of Trees > By Strata 

This table provides total estimates of stormwater runoff avoided due to trees by strata in your 

study area. This table includes estimates for the following: 

 Number of trees 

 Leaf area 

 Potential evapotranspiration 

 Evaporation 

 Transpiration 

 Water intercepted 

 Avoided runoff 

 Avoided runoff value 
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Oxygen Production of Trees > By Strata 

This report provides total estimates of oxygen production of trees by strata in your study area. 

Results are displayed in bar chart and table formats. 

 

Oxygen Production of Trees > By Strata per Unit Area 

This report provides per area (density) estimates of oxygen production of trees by strata in your 

study area. Per area estimates are calculated by dividing the total oxygen production in each 

stratum by the area of the stratum. Results are displayed in bar chart and table formats. 

 

Pollution Removal by Trees and Shrubs > Monthly Removal 

This table provides total monthly and annual estimates of pollution removal and associated 

value by the trees and shrubs in your study area. This table displays minimum, maximum, and 

mean pollution removal and value results for the following pollutants: 

 Nitrogen dioxide (NO2) 

 Sulfur dioxide (SO2) 

 Ozone (O3) 

 Carbon monoxide (CO) 

 Particulate matter less than 2.5 microns (PM2.5) 

(Note: While particulate matter smaller than 10 microns (PM10) is a significant air pollutant, it is 

not included in this analysis because i-Tree Eco analyzes particulate matter less than 2.5 

microns (PM2.5), which is a subset of PM10. PM2.5 is generally more relevant in discussions 

concerning air pollution effects on human health.) 

 

Pollution Removal by Trees and Shrubs > Monthly Removal (chart display) 

This report provides total monthly estimates of pollution removal and associated value by the 

trees and shrubs in your study area. The report displays charts and tables for the following 

pollutants: 

 Nitrogen dioxide (NO2) 

 Sulfur dioxide (SO2) 

 Ozone (O3) 

 Carbon monoxide (CO) 

 Particulate matter less than 2.5 microns (PM2.5) 

Several of the charts and tables in this report present pollution removal and the associated 

value for all of the pollutants studied. The remaining charts show pollution removal and value for 

each pollutant individually. (Note: While particulate matter smaller than 10 microns (PM10) is a 

significant air pollutant, it is not included in this analysis because i-Tree Eco analyzes particulate 

matter less than 2.5 microns (PM2.5), which is a subset of PM10. PM2.5 is generally more relevant 

in discussions concerning air pollution effects on human health.) 

 

VOC Emissions of Trees > By Species 

This table provides total estimates of volatile organic compounds (VOC) emissions from the tree 

species in your study area, including monoterpene, isoprene, and the sum of both. 

 

VOC Emissions of Trees > By Strata 
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This table provides total estimates of volatile organic compounds (VOC) emissions of trees by 

strata in your study area, including monoterpene, isoprene, and the sum of both. 

 

UV Effects of Trees > By Strata 

This table provides estimates of the effects that trees have on the ultraviolet (UV) radiation 

received in your study area. UV radiation is emitted by the sun and while beneficial to humans in 

small doses, can have negative health effects when people are overexposed. The UV index 

scale was developed by the World Health Organization to more easily communicate daily levels 

of UV radiation and alert people to when protection from overexposure is needed most. UV 

index values are estimated from UV radiation and adjusted based on local elevation and cloud 

cover. Tree canopies help to reduce the amount of UV radiation that reaches the ground thus 

providing people with additional protection from the sun’s harmful rays. UV effects are reported 

in this table for each stratum and the study area as a whole and broken into the following 

results: 

 UV Effects in Tree Shade – changes in UV for a person who is always shaded by tree 

canopy. For example, someone who is sitting under a tree. 

 UV Effects Overall – changes in UV for a person who is in both areas that are shaded by 

tree canopy and areas that are not. For example, someone who is walking down a street 

may find themselves under tree canopy at some times and exposed to full UV radiation 

at others. 

Results are additionally reported for the following: 

 Protection factor – a unitless value meant to capture the UV radiation-blocking capacity 

of trees. It is comparable to the SPF rating in sunscreen and calculated as unshaded UV 

index divided by shaded or overall UV index. 

 Reduction in UV Index – the change in UV index as the result of trees and calculated as 

unshaded UV index minus shaded or overall UV index. 

 Percent reduction – the reduction in UV index expressed as a percent change and 

calculated as the reduction in UV index divided by unshaded UV index. 

 

Wildlife Suitability > By Plot 

This table provides estimates of wildlife suitability for each plot in your study area. The suitability 

index reported here is a unitless value meant to capture the ability of an area to sustain a 

population based on the habitat features that relate to and influence the patterns of abundance 

of each species. Two suitability index values are given for each plot. One value is based on the 

trees that were sampled on the plot and the other value assumes an absence of trees on the 

plot. The index change due to trees is estimated as the following: 

 A relative change calculated as the absolute change (see below) divided by the 

suitability index with trees. 

 An absolute change calculated as the suitability index with trees minus the suitability 

index without trees. 

The wildlife species reported here are based on species’ ranges so only those species present 

in the study area will be included in the report. Data is available for up to nine bird species, 

including American robin, Baltimore oriole, black-capped chickadee, Carolina chickadee, 

European starling, northern cardinal, red-bellied woodpecker, scarlet tanager, and wood thrush. 
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Wildlife Suitability > By Strata 

This table provides estimates of wildlife suitability for each stratum and your study area as a 

whole. The suitability index reported here is a unitless value meant to capture the ability of an 

area to sustain a population based on the habitat features that relate to and influence the 

patterns of abundance of each species. Two suitability index values are given for each stratum. 

One value is based on the trees in that stratum and the other value assumes an absence of 

trees in the stratum. The index change due to trees is estimated as the following: 

 A relative change calculated as the absolute change (see below) divided by the 

suitability index with trees. 

 An absolute change calculated as the suitability index with trees minus the suitability 

index without trees. 

The wildlife species reported here are based on species’ ranges so only those species present 

in the study area will be included in the report. Data is available for up to nine bird species, 

including American robin, Baltimore oriole, black-capped chickadee, Carolina chickadee, 

European starling, northern cardinal, red-bellied woodpecker, scarlet tanager, and wood thrush. 

 

Management Costs > By Expenditure 

This table reports the user-defined expenditures for managing the trees in your study area. 

From the total costs reported, the cost per tree and cost per capita are also estimated and 

presented in this table. Management costs are defined by the user in the Annual Costs function 

of the Data tab. To edit your annual costs, open that function and follow the steps outlined in the 

Help panel. This form can be edited at any time and you will not be required to submit your 

project again. Results on the Reports tab will reflect the change in annual costs immediately. 

 

Net Annual Benefits > Net Annual Benefits for All Trees 

This table reports the economic value of the environmental benefits provided by all of the trees 

in your study area. The user-defined management costs are reported so that net benefits and 

benefit-cost ratio can be estimated for your study area. From the total benefits and costs 

reported, per tree and per capita estimates are also presented in this table. Management costs 

are defined by the user in the Annual Costs function of the Data tab. To edit your annual costs, 

open that function and follow the steps outlined in the Help panel. This form can be edited at 

any time and you will not be required to submit your project again. Results on the Reports tab 

will reflect the change in annual costs immediately. 

 

Measured Tree Details Reports 

 

Composition and Structure > Individual Tree Data 

This table presents a summary of the data collected in the field as well as additional estimated 

tree characteristics for each of the trees sampled in your study area. The table includes 

estimates for the following characteristics: 

 Tree ID 

 Species name 
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 Diameter at breast height (DBH) 

 Height 

 Canopy cover 

 Tree condition 

 Leaf area 

 Leaf biomass 

 Leaf area index – estimated by dividing leaf area by canopy cover 

 Basal area 

 Street tree 

 Native to state 

For users providing custom classes, refer back to the Condition or Dieback function of the 

Project Configuration tab to see how the default classes displayed here are defined in terms 

of your custom classes. Please be aware that using custom classes makes comparing results 

across projects more difficult and should be done with caution. 

 

Composition and Structure > By Species 

This table presents a summary of the data collected in the field as well as additional estimated 

tree characteristics for each of the species in your study area. The table includes estimates for 

the following characteristics: 

 Tree count 

 Canopy cover 

 Leaf area 

 Leaf biomass 

 Basal area 

 

Composition and Structure > By Strata 

This table presents a summary of the data collected in the field as well as additional estimated 

tree characteristics for each of the strata in your study area. The table includes estimates for the 

following characteristics: 

 Tree count 

 Canopy cover 

 Leaf area 

 Leaf biomass 

 Basal area 

 

Benefits and Costs > Individual Tree Benefits Summary 

This table provides a summary of Eco’s benefit estimates, including structural value, energy 

savings, carbon storage and sequestration, avoided runoff, and pollution removal, for each of 

the trees sampled in your study area. 

 

 

Benefits and Costs > Carbon Storage 

This table provides estimates of carbon storage for each of the trees sampled in your study 
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area. The percent contribution to the total carbon storage of all sampled trees is also reported. 

 

Benefits and Costs > Carbon Sequestration 

This table provides estimates of carbon sequestration for each of the trees sampled in your 

study area. The percent contribution to the total carbon sequestration of all sampled trees is 

also reported. 

 

Benefits and Costs > Energy Effects 

This table provides total estimates of the effect of each tree sampled in your study area on 

energy usage. The table includes estimates for the following energy effects: 

 Effect on building energy use (i.e., increases or decreases in the number of MBTUs and 

MWHs used for heating or cooling residential buildings in study area) 

 Value of effects (i.e., values associated with the changes in building energy use) 

 

Benefits and Costs > Avoided Runoff 

This table provides total estimates of the stormwater runoff avoided due to each tree sampled in 

your study area. The table includes estimates for the following: 

 Leaf area 

 Potential evapotranspiration 

 Evaporation 

 Transpiration 

 Water intercepted 

 Avoided runoff 

 Avoided runoff value 

 

Benefits and Costs > Pollution Removal 

This table presents total estimates of pollution removal, associated pollution removal value, and 

volatile organic compound emissions for each of the trees sampled in your study area. The table 

reports estimates for the following pollutants: 

 Nitrogen dioxide (NO2) 

 Sulfur dioxide (SO2) 

 Ozone (O3) 

 Carbon monoxide (CO) 

 Particulate matter less than 2.5 microns (PM2.5) 

 Monoterpene 

 Isoprene 

(Note: While particulate matter smaller than 10 microns (PM10) is a significant air pollutant, it is 

not included in this analysis because i-Tree Eco analyzes particulate matter less than 2.5 

microns (PM2.5), which is a subset of PM10. PM2.5 is generally more relevant in discussions 

concerning air pollution effects on human health.) 

 

Benefits and Costs > Oxygen Production 

This table provides total estimates of the oxygen production of each tree sampled in your study 
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area. 

 

Benefits and Costs > VOC Emissions 

This table provides total estimates of the volatile organic compounds (VOC) emissions of each 

tree sampled in your study area, including monoterpene, isoprene, and the sum of both. 

 

Air Quality and Public Health Report 

 

This report provides estimates of the number of adverse health incidents that were avoided due 

to changes in pollutant concentration levels. The estimates in the table reflect the population of 

your study area. The dollar values reflect the economic value of those reductions in health 

incidents. The same health effects are not analyzed for each pollutant. Blank values indicate 

that incidence reduction and value are not estimated for that pollutant and health effect. For 

example, acute bronchitis is only estimated for particulate matter less than 2.5 microns (PM2.5) 

 

Pest Analysis Reports 

 

Susceptibility to Pests > By Strata 

This table displays results for 36 pests and diseases. Results are reported as the number of 

trees by strata that are susceptible or not susceptible to each pest. Structural value and leaf 

area are also estimated based on the number of trees. 

 

Primary Pest > Impacts by Strata 

This table displays results for the pests that were detected in your study area (based on signs 

and symptoms reported following the Pest Detection Module protocol). 

 

 

Reports summarizing documented signs and symptoms of tree pests and 

diseases require the collection of additional pest data. Please refer back to 

Phase III: Collecting Your Field Data for more information on the 

requirements for the supplemental pest analysis. 

Tip 

 

 

The susceptibility report does not reflect field-collected data about actual risks 

and harm, but rather calculates the damage from a potential outbreak based 

on species diversity in your population. This susceptibility report will continue 

to be fully functional whether or not you choose to collect the supplemental 

pest detection data. 

 

Tip 
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Primary Pest > Impacted Tree Details 

This table displays results for the pests that were detected in your study area (based on signs 

and symptoms reported following the Pest Detection Module protocol). 

 

Signs & Symptoms > Totals by Species 

This table displays the percent of trees that are affected by pests for each tree species sampled 

(based on signs and symptoms reported following the Pest Detection Module protocol). 

 

Signs & Symptoms > Summaries by Species 

This table displays the percent of trees that exhibit a condition for each tree species sampled 

(based on signs and symptoms reported following the Pest Detection Module protocol). The 

table shows a summary of the more detailed results as well as the percent of trees affected by 

each sign or symptom for each of the tree species sampled. 

 

Signs & Symptoms > Details by Species 

This table displays the percent of trees that exhibit a condition for each tree species sampled 

(based on signs and symptoms reported following the Pest Detection Module protocol). The 

table shows the complete detailed results as well as the percent of trees affected by each sign 

or symptom for each of the tree species sampled. 

 

Signs & Symptoms > Totals by Strata 

This table displays the percent of trees that are affected by pests in each stratum (based on 

signs and symptoms reported following the Pest Detection Module protocol). 

 

Signs & Symptoms > Summaries by Strata 

This table displays the percent of trees that exhibit a condition for each stratum (based on signs 

and symptoms reported following the Pest Detection Module protocol). The table shows a 

summary of the more detailed results as well as the percent of trees affected by each sign or 

symptom for each stratum. 

 

Signs & Symptoms > Details by Strata 

This table displays the percent of trees that exhibit a condition for each stratum (based on signs 

and symptoms reported following the Pest Detection Module protocol). The table shows the 

complete detailed results as well as the percent of trees affected by each sign or symptom for 

each stratum. 

 

Signs & Symptoms > Impacted Tree Finder 

This table is an interactive display that allows you to choose which pest signs and symptoms 

you are most interested in. 

 

Pest Review > Of Assessed Trees 

This table is an interactive display that allows you to choose which pest you are most interested 

in and view the tree species that exhibit the signs and symptoms associated with that pest. 
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Pollution and Weather Reports 

 

Raw and Source Data > Air Pollutant Concentration 

This report displays the hourly pollution concentration based on air quality data. Results are 

displayed in line chart and table formats for the user-designated pollution year. Estimates are 

reported for the following pollutants: 

 Nitrogen dioxide (NO2) 

 Sulfur dioxide (SO2) 

 Ozone (O3) 

 Carbon monoxide (CO) 

 Particulate matter less than 2.5 microns (PM2.5) 

 

Raw and Source Data > Photosynthetically Active Radiation 

This report displays the hourly photosynthetically active radiation based on weather data. 

Results are displayed in line chart and table formats for the user-designated weather year. 

 

Raw and Source Data > Rain 

This report displays the hourly precipitation based on weather data. Results are displayed in line 

chart and table formats for the user-designated weather year. 

 

Raw and Source Data > Temperature 

This report displays hourly air temperature based on weather data. Results are displayed in line 

chart and table formats for the user-designated weather year. 

 

Raw and Source Data > UV Index 

This report displays the daily ultraviolet (UV) index in your study area. UV radiation is emitted by 

the sun and while beneficial to humans in small doses, can have negative health effects when 

people are overexposed. The UV index scale was developed by the World Health Organization 

to more easily communicate daily levels of UV radiation and alert people to when protection 

from overexposure is needed most. UV index values are estimated from UV radiation and 

adjusted based on local elevation and cloud cover. Results are displayed in line chart and table 

formats. UV data is from the same year as the user-designated weather and pollution year. It is 

presented as a daily value at solar noon when the sun is highest in the sky. 

 

Air Quality Improvement > By Trees 

This report displays hourly air quality improvement provided by the tree cover in your study 

area. Results are displayed in line chart and table formats for the user-designated pollution 

year. Estimates are reported for the following pollutants: 

 Nitrogen dioxide (NO2) 

 Sulfur dioxide (SO2) 

 Ozone (O3) 

 Carbon monoxide (CO) 
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 Particulate matter less than 2.5 microns (PM2.5) 

 

Air Quality Improvement > By Shrubs 

This report displays hourly air quality improvement provided by the shrub cover in your study 

area. Results are displayed in line chart and table formats for the user-designated pollution 

year. Estimates are reported for the following pollutants: 

 Nitrogen dioxide (NO2) 

 Sulfur dioxide (SO2) 

 Ozone (O3) 

 Carbon monoxide (CO) 

 Particulate matter less than 2.5 microns (PM2.5) 

 

Air Pollutant Flux (Dry Deposition) > Per Unit Tree Cover 

This report displays hourly dry deposition of air pollutants per unit of tree cover. Results are 

displayed in line chart and table formats for the user-designated pollution year. Estimates are 

reported for the following pollutants: 

 Nitrogen dioxide (NO2) 

 Sulfur dioxide (SO2) 

 Ozone (O3) 

 Carbon monoxide (CO) 

 Particulate matter less than 2.5 microns (PM2.5) 

 

Air Pollutant Flux (Dry Deposition) > Per Unit Shrub Cover 

This report displays hourly dry deposition of air pollutants per unit of shrub cover. Results are 

displayed in line chart and table formats for the user-designated pollution year. Estimates are 

reported for the following pollutants: 

 Nitrogen dioxide (NO2) 

 Sulfur dioxide (SO2) 

 Ozone (O3) 

 Carbon monoxide (CO) 

 Particulate matter less than 2.5 microns (PM2.5) 

 

Transpiration > By Trees 

This report displays hourly transpiration by trees. Transpiration is the amount of water moved 

through plants and released to the atmosphere. Results are displayed in line chart and table 

formats for the user-designated weather year. 

 

Transpiration > By Shrubs 

This report displays hourly transpiration by shrubs. Transpiration is the amount of water moved 

through plants and released to the atmosphere. Results are displayed in line chart and table 

formats for the user-designated weather year. 

 

Evaporation > By Trees 
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This report displays the hourly evaporation by trees. Evaporation is the amount of water that is 

released to the atmosphere from the plant’s surface. Results are displayed in line chart and 

table formats for the user-designated weather year. 

 

Evaporation > By Shrubs 

This report displays the hourly evaporation by shrubs. Evaporation is the amount of water that is 

released to the atmosphere from the plant’s surface. Results are displayed in line chart and 

table formats for the user-designated weather year. 

 

Water Intercepted > By Trees 

This report displays the hourly water interception by trees. Water intercepted is the amount of 

rainfall that fell on plants and was intercepted by the plant’s leaves. This water is eventually 

evaporated to the atmosphere. Results are displayed in line chart and table formats for the user-

designated weather year. 

 

Water Intercepted > By Shrubs 

This report displays the hourly water interception by shrubs. Water intercepted is the amount of 

rainfall that fell on plants and was intercepted by the plant’s leaves. This water is eventually 

evaporated to the atmosphere. Results are displayed in line chart and table formats for the user-

designated weather year. 

 

Avoided Runoff > By Trees 

This report displays the hourly avoided runoff by trees. Avoided runoff is the amount of water 

that would become surface runoff to streams, but does not. Estimates incorporate water 

interception by plants, ground depression storage, infiltration on pervious ground covers, and 

overland flow on impervious ground covers. Results are displayed in line chart and table formats 

for the user-designated weather year. 

 

Avoided Runoff > By Shrubs 

This report displays the hourly avoided runoff by shrubs. Avoided runoff is the amount of water 

that would become surface runoff to streams, but does not. Estimates incorporate water 

interception by plants, ground depression storage, infiltration on pervious ground covers, and 

overland flow on impervious ground covers. Results are displayed in line chart and table formats 

for the user-designated weather year. 

 

Potential Evapotranspiration > By Trees 

This report displays the hourly potential evapotranspiration by trees. Potential 

evapotranspiration is the sum of the evaporation from the soil and the transpiration from plants 

that would occur if an unlimited amount of water were available. Results are displayed in line 

chart and table formats for the user-designated weather year. 

 

Potential Evapotranspiration > By Shrubs 

This report displays the hourly potential evapotranspiration by shrubs. Potential 

evapotranspiration is the sum of the evaporation from the soil and the transpiration from plants 
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that would occur if an unlimited amount of water were available. Results are displayed in line 

chart and table formats for the user-designated weather year. 

 

UV Index Reduction by Trees > Effects in Tree Shade 

This report displays the daily reduction in UV index by trees in your study area. Ultraviolet (UV) 

radiation is emitted by the sun and while beneficial to humans in small doses, can have negative 

health effects when people are overexposed. The UV index scale was developed by the World 

Health Organization to more easily communicate daily levels of UV radiation and alert people to 

when protection from overexposure is needed most. UV index values are estimated from UV 

radiation and adjusted based on local elevation and cloud cover. Tree canopies help to reduce 

the amount of UV radiation that reaches the ground thus providing people with additional 

protection from the sun’s harmful rays. Effects in tree shade are changes in UV for a person 

who is always shaded by tree canopy. For example, someone who is sitting under a tree. 

Reduction in UV Index in tree shade is calculated as unshaded UV index minus shaded UV 

index. Results are displayed in line chart and table formats. UV data is from the same year as 

the user-designated weather and pollution year. It is presented as a daily reduction at solar 

noon when the sun is highest in the sky. 

 

UV Index Reduction by Trees > Effects Overall 

This report displays the daily reduction in UV index by trees in your study area. Ultraviolet (UV) 

radiation is emitted by the sun and while beneficial to humans in small doses, can have negative 

health effects when people are overexposed. The UV index scale was developed by the World 

Health Organization to more easily communicate daily levels of UV radiation and alert people to 

when protection from overexposure is needed most. UV index values are estimated from UV 

radiation and adjusted based on local elevation and cloud cover. Tree canopies help to reduce 

the amount of UV radiation that reaches the ground thus providing people with additional 

protection from the sun’s harmful rays. Overall effects are changes in UV for a person who is in 

both areas that are shaded by tree canopy and areas that are not. For example, someone who 

is walking down a street may find themselves under tree canopy at some times and exposed to 

full UV radiation at others. Reduction in UV Index overall is calculated as unshaded UV index 

minus overall UV index. Results are displayed in line chart and table formats. UV data is from 

the same year as the user-designated weather and pollution year. It is presented as a daily 

reduction at solar noon when the sun is highest in the sky. 

 

Model Notes 

 

This report provides more information about the data processing that occurs within the Eco 

model. For example, notes here may indicate that energy data collected for a specific tree was 

invalid and therefore the estimated energy effects do not include that specific tree. The key 

below the processing notes can be used to decipher any errors that occurred and determine 

how to resolve them. 
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The standard reports provided by Eco can easily be saved or printed so you can make use of 
them outside the application. After opening a report, a toolbar will become available in the action 
panel of the Eco window. Reports can be saved in pdf, xlsx, xls, rtf, or docx format.   
 

Pack Project 

 

The Pack Project option allows you to create a zip folder that includes all the necessary 

information to transfer your Eco project from one computer to another or to share the project 

with another user. To begin the process: 

 

1 Click File > Pack Project. 

2 Browse to the folder where you would like to save your zip file, enter a file name, and 

click Save. 

 

To unpack the project on the new computer: 

 
1 Navigate to the folder where you saved your zip file. 

2 Right-click on the zip file and extract files. 

The project can now be accessed from the Eco application by opening the project file. 

 

  

 Sharing Your Project 
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i-Tree Eco 

 

The user interface of the i-Tree Eco program is organized as shown below. Throughout the help 

text and User’s Manual, there will be references to the various features explained here. 

 

Features: 

1 File menu – This drop-down menu provides options to start a new project, open an 

existing project, save your project, etc. 

2 Tabs – i-Tree Eco has six tabs to choose from that bring up specific functions in the 

ribbon. Tab options include: 

 Project Configuration 

 Data 

 View 

Glossary 

1 2 

3 
5 

4 

6 7 
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 Reports 

 Forecast 

 Support 

3 Ribbon – The ribbon bar provides access to the groups and functions that are available 

for each selected tab. 

4 Group – Similar functions are organized into each group. 

5 Function – The various buttons or drop-down lists in the ribbon make project settings, 

data entry, and report features available in the action panel. 

6 Action Panel – This is where you input and edit your project settings and data, as well 

as view reports. 

7 Info Panel – This is where you can view help text for the many features of i-Tree Eco. 

The panel can be minimized and maximized as desired. 

 

Resource Structure 

 

Condition – Relating to the tree crown health (e.g., poor condition, good, dead/dying). This 

variable is assessed in the field by identifying a tree’s crown condition or dieback. 

 

Diameter at breast height (DBH) – The diameter of the tree stem measured at 4.5 feet (1.37 

meters) above the ground (breast height). 

 

Importance value (IV) –Relating to the dominance of a tree species in the urban forest. 

Importance value is calculated as the sum of the percent population and percent leaf area.  High 

importance values do not mean that these trees should necessarily be encouraged in the future; 

rather these species currently dominate the urban forest structure. 

 

Leaf area – The total one-sided surface area contributed by all of the leaves on the trees. Leaf 

area is estimated using measurements of crown dimensions and percentage of crown canopy 

missing. 

 

Leaf area index (LAI) – The total one-sided leaf surface area per unit of ground surface area. 

Leaf area index is estimated by dividing the leaf area by the ground area. Higher LAIs indicate a 

greater number of leaves per unit of ground area. 

 

Leaf biomass – The total living mass contributed by all of the leaves on the sampled trees. 

 

Origin – Relating to the continent or region that a particular tree species is native to (i.e., where 

the species developed or occurs naturally). 

 

Rarefaction – A technique used for assessing species richness of a sample of trees. Using this 

technique, species richness in estimated by plotting the number of species against the number 

of samples to create rarefaction curves. For i-Tree, the value produced using the rarefaction 

technique is the number of species one would expect to find if 4 trees were sampled in each 
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stratum. For the entire study area, this value is the number of species one would expect to find if 

250 trees were sampled within the study area. 

 

Species diversity – The number of different species that are represented in the study area. 

Species diversity takes into account both species richness and species evenness. 

 

Species dominance – A measure of the degree to which a species is more numerous than 

others or contributes more of the total biomass. 

 

Species evenness – A measure of how closely matched the numbers of each species are to 

each other. 

 

Species richness – The number of different species that are represented in the study area. 

 

Ecosystem Services 

 

Avoided runoff – A measure of the stormwater runoff that is avoided because of rainfall 

interception by trees, which partially intercept precipitation on their leaves and other surfaces. 

Avoided runoff is estimated by comparing the hourly precipitation processes and total annual 

surface runoff volume modeled for the study area as it occurs with trees present and as it would 

occur if there were no trees. 

 

VOC Emissions – A measure of the volatile organic compounds (VOC) released. Trees release 

VOC emissions, specifically isoprene and monoterpene, which can contribute to the formation of 

ozone and carbon monoxide. The amount of emissions depends on tree species, leaf, biomass, 

air temperature, and other environmental factors.  

 

Carbon sequestration – A measure of the carbon (in the form of carbon dioxide) that is 

removed from the atmosphere by trees. 

 Gross sequestration – A measure of the carbon sequestered by trees calculated as the 

difference in estimates of carbon storage between Year X and Year X +1. 

 Net sequestration – A measure of the carbon sequestered by trees calculated as the 

gross carbon sequestered minus the carbon emissions due to decomposition after tree 

death. 

 

Carbon storage – A measure of the carbon that is stored within trees. This is the amount of 

carbon that is bound up in both the above-ground and below-ground parts of woody vegetation. 

 

Energy effects – A measure of the seasonal effects of trees on residential building energy use 

and consequent emissions from power plants. Energy effects are estimated based on tree 

distance and direction to residential structures, tree height, and tree condition. 

 Energy use – Increases or decreases in the number of MBTUs and MWHs used for 

heating or cooling residential buildings that are affected by trees, which affect energy 
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use by modifying local the immediate climate, producing shade, and reducing wind 

speeds. 

 Emissions – Increases or decreases in carbon emissions from power plants as a result 

of changes in energy use. 

 

Evaporation – The amount of water that is released to the atmosphere from the plant’s surface. 

 

Oxygen production – A measure of the oxygen produced by trees during photosynthesis, 

taking into account the amount consumed during plant respiration. This net oxygen production is 

calculated from carbon sequestration estimates based on atomic weight. 

 

Pollution removal – A measure of the air pollution that is removed from the atmosphere by 

trees. Pollution removal is calculated for nitrogen dioxide (NO2), sulfur dioxide (SO2), ozone 

(O3), carbon monoxide (CO), and particulate matter less than 2.5 microns (PM2.5). Trees remove 

gaseous air pollution primarily by uptake via leaf stomata, though some gases are removed by 

the plant surface. Trees also remove pollution by intercepting airborne particles. Some particles 

can be absorbed into the tree, though most particles that are intercepted are retained on the 

plant surface. 

 

Potential evapotranspiration – The sum of the evaporation from the soil and the transpiration 

from plants that would occur if an unlimited amount of water were available. 

 

Transpiration – The amount of water moved through plants and released to the atmosphere. 

 

UV index – Ultraviolet (UV) radiation is emitted by the sun and while beneficial to humans in 

small doses, can have negative health effects when people are overexposed. The UV index 

scale was developed by the World Health Organization to more easily communicate daily levels 

of UV radiation and alert people to when protection from overexposure is needed most. 

 

Water intercepted – The amount of rainfall that fell on plants and was intercepted by the plant’s 

leaves. This water is eventually evaporated to the atmosphere. 

 

Values 

 

Avoided runoff value – A functional value provided by the trees (i.e., a value that results from 

an environmental function of trees). This is the monetary value of stormwater runoff that is 

avoided because of rainfall interception by trees. This value is estimated based on the economic 

damages associated with runoff and costs of stormwater control. 

 

Carbon sequestration value - A functional value provided by the trees (i.e., a value that results 

from an environmental function of trees). This is the monetary value associated with tree effects 

on atmospheric carbon. This value is estimated based on the economic damages associated 

with increases in carbon or carbon dioxide emissions. 
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Carbon storage value – A structural value based on the tree itself. This is the monetary value 

associated with tree effects on atmospheric carbon. This value is estimated based on the 

economic damages associated with increases in carbon or carbon dioxide emissions. 

 

Compensatory value – A structural value based on the tree itself. The compensatory value is 

based on the cost of having to replace a tree with a similar tree. 

 

Energy effects value – A functional value provided by the trees (i.e., a value that results from 

an environmental function of trees). 

 Energy use – The monetary value of increased or decreased energy costs as a result of 

a tree’s effect on residential building energy use. This value is estimated based on the 

dollar value per MBTU or MWH. 

 Emissions – The monetary value of increases or decreases in carbon emissions from 

power plants as a result of changes in energy use. This value is estimated based on the 

economic damages associated with increases in carbon or carbon dioxide emissions. 

 

Pollution removal value – A functional value provided by the trees (i.e., a value that results 

from an environmental function of trees). This is the monetary value associated with tree effects 

on atmospheric pollution. This value is estimated based on the economic damages associated 

with increases in pollution emissions and/or the impact of air pollution on human health. 


